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Introduction

Editor’s ToolKit Plus is a comprehensive suite of editing programs including Editor’s ToolKit, FileCleaner, NoteStripper, and QuarkConverter, all integrated into one program. I originally designed these programs for my own use and then realized that others might find them useful too. This documentation consists of the combined documentation for the individual programs.

By using Editor’s ToolKit Plus, you accept the terms of agreement found at the end of this document. The first time you use Editor’s ToolKit Plus, the terms of agreement will appear on your screen. Please read them carefully. If you accept the terms, you will be able to use the program. If not, you will not be able to use it.

Macros and Templates

Editor’s ToolKit Plus is basically a collection of macros in a template (named ETKPlus.dot). You don’t use this template as you would an ordinary template by attaching it to a document. If you try to do that, you’ll run into problems. Instead, you “add” it to Microsoft Word as a global template or add-in (see installation instructions below).

Because the template contains macros, some virus-checking programs or even Word itself may warn you that the template could contain Word viruses. Please rest assured that it does not. The macros have been carefully checked and tested to make sure they are safe and usable. To ensure your security, you should download the program directly from my Web site at www.editorium.com.

Please do not rename any of the Editor’s ToolKit Plus macros, copy them to another template, or remove them from the Editor’s ToolKit Plus template. Editor’s ToolKit Plus uses these macros in combination and will not work properly if they have been copied to another template or renamed, or if some of the macros are no longer present.

Installing Editor’s ToolKit Plus

To install the program:

1. Unzip (or unstuff) the program files so that they’re all together in a single folder or on your desktop. (If you need software to unzip or unstuff the program, you can download it from www.winzip.com or www.aladdinsys.com.) You cannot install the program by just opening the zip file and double-clicking one of the files.
2. After the files are unzipped, open the file named “Install Editor’s ToolKit Plus.dot” in Microsoft Word by clicking File > Open, selecting the file, and clicking the Open button. Do not open the file by double-clicking it outside of Microsoft Word. If you do, you’ll run into problems later.

3. If Word asks if you want to “enable macros” when opening the file, your answer should be yes. Otherwise, the program won’t work. If Word tells you that the macros have been disabled, you’ll need to change your macro security settings and then restart Word before installing. Please see the “Troubleshooting” section at the end of this document for more information.

4. Double-click the large button that says “Double-Click here to Install.” This will install Editor’s ToolKit Plus as a global template or add-in, which simply means that the program will be saved to Word’s Startup folder and will thus be available any time you start Word.

5. Restart Word to activate the program and display the Editor’s ToolKit menu at the top of your Word window. (The “Plus” items—FileCleaner, NoteStripper, and QuarkConverter—are the first thing under the Editor’s ToolKit menu.) In Word 2007, the menu will be displayed under Word’s “Add-ins” menu.
If that doesn’t  work, you can install the program manually. With Microsoft Word closed:

1.
On your computer desktop, double-click My Computer. (On a Macintosh, open your hard drive. Then continue with step 5, below.)

2.
At the top of the window that opens, you’ll see a “Tools” menu. Click that, and then click “Folder Options.”

3.
Click the “View” tab and make sure that “Show hidden files and folders” is selected. Then click the OK button.

4.
Back in the window for “My Computer,” double-click your local hard drive, probably “C.”

5.
Open the folders named, consecutively within each other, Documents and Settings > [your name] > Application Data > Microsoft > Word > Startup. (On a Macintosh, open Applications > Microsoft Office > Office > Startup > Word.)

6.
Put the file named “ETKPlus.dot” into the Startup folder (on a Macintosh, into the Startup > Word folder).

7.
Restart Microsoft Word.

Uninstalling Editor’s ToolKit Plus

To uninstall Editor’s ToolKit Plus:

1. Open the file named “Install Editor’s ToolKit Plus.dot” in Microsoft Word by clicking File > Open, selecting the template, and clicking the Open button. Do not open the file by double-clicking it outside of Microsoft Word. If you do, you’ll run into problems later.

2. If Word asks if you want to “enable macros” when opening the file, your answer should be yes. Otherwise, the program won’t work. If Word tells you that the macros have been disabled, you’ll need to change your macro security settings in order to use the program. Please see the “Troubleshooting” section of this documentation for more information.

3. Double-click the large button that says “Double-Click here to Uninstall.”

If necessary, you can remove the template manually from Word’s Startup folder:

1.
On your computer desktop, double-click My Computer. (On a Macintosh, open your hard drive. Then continue with step 5, below.)
2.
At the top of the window that opens, you’ll see a “Tools” menu. Click that, and then click “Folder Options.”
3.
Click the “View” tab and make sure that “Show hidden files and folders” is selected. Then click the OK button.

4.
Back in the window for “My Computer,” double-click your local hard drive, probably “C.”
5.
Open the folders named, consecutively within each other, Documents and Settings > [your name] > Application Data > Microsoft > Word > Startup. (On a Macintosh, open Applications > Microsoft Office > Office > Startup > Word.)
6.
Remove the file named “ETKPlus.dot.”
7.
Restart Microsoft Word.

Other Editor's ToolKit Plus Files
The other files that come with Editor's ToolKit Plus should go in the following folders:

Microsoft Word Templates folder:

TYPESPEC.DOT (template containing styles for marking spec levels, explained below)

AUTOMACS.DOT (template containing auto macros, explained below)

STLSHEET.DOT (the editorial stylesheet template, explained below)

Documents folder:

ETKPLUS INSTRUCTIONS.DOC (the Editor's ToolKit Plus documentation in a Word document)

KEYBTEMP.DOC (the Editor's ToolKit keyboard template, explained below)

Using Editor’s ToolKit Plus

When you first begin using Editor’s ToolKit Plus, you’ll notice the new Editor’s ToolKit menu at the top of your screen. This menu includes the Editor’s ToolKit and Editor’s ToolKit Plus features as well as certain built-in Microsoft Word features that are useful for editing. You’ll also notice that many of the function keys have new functions. All of these commands and functions are explained in this documentation.

Closing Editor’s ToolKit Plus

If you need to close Editor’s ToolKit Plus and restore Word to its original “general user” configuration, click the Editor’s ToolKit menu and then click “Close Editor’s ToolKit Plus.”

Restarting Editor’s ToolKit Plus

To restart Editor’s ToolKit Plus:

Click the Tools menu at the top of your screen, click “Templates and Add-ins,” and click (check) the box next to ETKPLUS.DOT. Then click OK.

Editor’s ToolKit

Thanks for using Editor’s ToolKit!

I’ve been editing books for more than twenty years. For twelve of those years, I’ve been editing on computer, but I’ve never been able to find a word processor designed specifically for editors. Finally I decided to make one, using Microsoft Word as a foundation. I chose Word because it already includes so many useful features for editors and, with its programming language, is so easily customizable. Also, Word is already widely used in the publishing industry, making it a natural choice.

I designed Editor’s ToolKit with one thing in mind—editing text. Now I can’t imagine working without it. And while editors will find the program extremely useful, it will also be of help to writers, typesetters, and desktop publishers.

In writing these instructions, I’m assuming you already know how to use Windows and Microsoft Word. If you don’t, please learn to do so before trying to use Editor’s ToolKit. (See appendix 1, “Word Functions for Editors.”) The Editor’s ToolKit documentation is not intended to take the place of the Windows or Word manuals and Help files or even to explain Word’s functions.

I strongly recommend that you try Editor’s ToolKit several times on a variety of test files until you understand fully how it works and what it can do. Also, before using Editor’s ToolKit at any time, be sure to back up your files. That way, you'll have something to go back to, if necessary.

Toolbars

Editor’s ToolKit comes with three toolbars named Editor’s ToolKit 1, Editor’s ToolKit 2, and Editor’s ToolKit 3.

The first toolbar activates functions that are more or less on a document level, such as arranging documents, checking spelling, and so on.

The second toolbar activates functions that are more or less on a text level, such as transposing characters and capitalizing words.

The third toolbar activates functions that make it easy to apply styles.

You can turn these toolbars on or off as you would any other toolbars in Word:

1. Under the View menu, choose Toolbars.

2. Check or uncheck the boxes next to the names of the toolbars.

3. Click OK.

Auto Macros

Editor’s ToolKit includes a template called AUTOMACS.DOT that contains several auto macros—that is, macros that will run automatically when you open a document, close a document, or exit Microsoft Word. The names of these macros are AutoOpen, AutoClose, and AutoExit.

AutoOpen

The AutoOpen macro runs automatically when you open a document. With your permission, it turns on revision marking, applies the TYPESPEC template, and locks the document’s pages. If you have FileCleaner or Editor’s ToolKit Plus, it also runs FileCleaner. Finally, if you’ve edited the document before, the macro takes you to the place in the document where you left off editing (which is marked with a bookmark named “Editing”).

The next time you open the document (assuming you’ve saved it), the AutoOpen macro will simply take you to the place where you left off editing. It won’t do the other things it usually does, knowing they have already been done.

If there’s a different template you’d rather have applied automatically, you can rename that template as TYPESPEC.DOT so the macro will use it rather than the TYPESPEC template that comes with Editor’s ToolKit.

AutoClose

The AutoClose macro runs automatically when you close a document. It marks the place in the document where you left off editing, using a bookmark named “Editing.”

AutoExit

The AutoExit macro runs automatically when you exit Word. It works exactly the same as the AutoClose macro.

Installing Auto Macros

To install the auto macros, you must copy them to your Normal template. First, however, make sure the Normal template doesn’t already contain macros with the same names. If it does, you’ll need to decide which macros are more important to you, and you may need to save your existing auto macros under a different name or copy them to a different template. Or, you can simply decide not to use the auto macros that come with Editor’s ToolKit.

Here’s how to copy the Editor’s ToolKit auto macros to your Normal template:

1. Under the Tools menu, select Macro.

2. In the Macro dialog box, click the Organizer button.

3. In the Organizer dialog box, click the Close File button on the left-hand side. The button will change to an Open File button.

4. Click the Open File button.

5. Select the AUTOMACS template in your templates folder.

6. Click Open.

7. Hold down the Ctrl key while you select all of the macros in AUTOMACS.DOT.

8. Press the Copy button to copy the macros to NORMAL.DOT.

9. Press the Close button on the lower right-hand side of the dialog box.

The auto macros are now copied to your Normal template, and they will run automatically when you open or close a document or exit Word.

Using the Keyboard Template

Part of what makes Editor’s ToolKit easy to use is the fact that the most frequently accessed functions are available on your computer’s function keys, so you can use the program without reaching for the mouse all the time. I strongly recommend that you learn and use these keys. To remind you of what the keys do, Editor’s ToolKit comes with a keyboard template that you can place above the function keys on your keyboard. The template comes in a document called KEYBTEMP.DOC. To use it:

1. Open KEYBTEMP.DOC in Word (it should be in your templates folder).

2. Print the template.

3. Cut off the excess paper below the bottom line of the template. (For durability, you could print the template on card stock and laminate it.)

4. Place the template above your function keys. (You may want to tape it in place.)

The bottom line on the template lists the functions that can be accessed simply by pressing the function keys, and these are the functions you’ll probably use most often. To use the functions on the next line up, hold down the Shift key while pressing the function keys. You can access the functions on the third line up by holding down the Control key, and those on the top line by holding down Shift + Control.

If you don’t want to use the Editor’s ToolKit keyboard combinations but like Microsoft Word’s original ones, thank you very much, here’s how to reset them:

1. Actually open the program template (such as Editkit.dot or ETKPlus.dot) in Microsoft Word.

2. Click the "Tools" menu.

3. Click "Customize."

4. Click the "Keyboard" button.

5. Make sure the "Save changes in" box shows the name of the program template (such as Editkit.dot or ETKPlus.dot). If you don’t make sure, you could wipe out your own custom keyboard combinations.

6. Click the "Reset All" button.

7. Click the "Yes" button.

8. Click the "Close" button.

9. Click the next "Close" button.

10. Save the change program template to your Startup folder.

11. Close the program template.

This will reset all of the program’s custom keyboard combinations to their Microsoft Word defaults.

Using the Editorial Style Sheet

Editor’s ToolKit includes a document template called STLSHEET.DOT, which should be in Word’s templates folder. You can use this template to create an editorial style sheet on which to record your editing decisions—unusual spellings, words to capitalize, and so on. To do so:

1. Under File, select New.

2. Click the STLSHEET template.

3. Click OK.

You can keep this new file open while you are editing and switch to it as needed to record your decisions. Then save it with the files for that job. Using an editorial style sheet is a good way to maintain consistency in editorial style throughout a manuscript.

Incidentally, if you find many inconsistencies in a manuscript, you may want to fix them by using the MegaReplacer program from the Editorium. MegaReplacer finds and replaces multiple words or phrases in multiple documents, all at one time. In addition, if you find yourself cleaning up lots of little things, like double spaces, improperly typed ellipses, ells used as ones, and so on, you may be interested in my FileCleaner program, which quickly and easily cleans up such typographical problems in the active document, all open documents, or all documents in a folder.

Features of Editor’s ToolKit

I’ve made Editor’s ToolKit’s most frequently used features accessible from the keyboard. Most of them are also accessible from the Editor’s ToolKit menu at the top of the screen, and many are available on the customized toolbars included with the program. In addition, some are available on the text shortcut menu accessed with the right mouse button. Following is an explanation of the program’s features and how to use them.

Show and Stet Revisions

You probably already know that Word will keep track of your revisions with colored strikeouts (for deletions) and underlining (for insertions)—the perfect feature for professional editing because it lets you see the changes you’ve made, just as if you were editing on paper. Unfortunately, Word has no easy, natural way to let you see and review all of your revisions at once or to easily and selectively undo them. Editor’s ToolKit fixes this problem, letting you see revisions at the touch of a key (F4). Then you can put your cursor on a revision, press the Stet key (F3), and watch the revision go back to the way it was. You can also select whole sections and stet them. Another keystroke (F4), and your revisions are hidden again. Of course, you can work with revisions hidden (my preference) or with revisions showing. For your convenience, showing revisions also lets you view invisible characters, such as spaces and carriage returns.

Access:

• F4 key to show or hide revisions


• F3 to stet revisions


• Editor’s ToolKit menu, Show or Hide Revisions


• Editor’s ToolKit menu, Stet Revisions


• Editor’s ToolKit 2 toolbar [image: image1.png]
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• Tools menu, Revisions

Editor’s ToolKit also gives you several easy ways to turn revision marking on or off:

Access:

• F2 Key


• Editor’s ToolKit menu, Mark Revisions


• Editor’s ToolKit 2 toolbar [image: image3.png]




• Tools menu, Revisions

Make Selection Title Case

Select the words you’d like to be in title case, then use this feature. The selected text will be placed in proper title case, with commonly used articles, prepositions, and conjunctions lowercased; other words uppercased; and first and last words uppercased. This is extremely useful if you’re working on a document with headings in all caps that need to be title case.

You’ll still need to review the text you change with this feature to make sure it’s capped the way you want it to be. Because of limitations on size and speed, the program can’t possibly take care of every word that should be lowercased.

Access:

• F9 with text selected


• Editor’s ToolKit menu, Make Selection Title Case


• Editor’s ToolKit 2 toolbar [image: image4.png]



Incidentally, if you need a heading to be all caps, LIKE THIS, you shouldn’t type it in all caps. Rather, you should make it title case and then format it as all caps in the style used with the heading. That way, if your design changes from all caps, the words will be in proper title case format with the modified style.

If you use “Make Selection Title Case” without making a selection, the current word will be capitalized.

Capitalize a Word

Put your cursor anywhere on a word, press the F9 function key, and this feature capitalizes the word (initial cap) and moves your cursor to the next word. That means you can jump from word to word, capping as you go. Incidentally, this function also turns a word in all caps to one that’s cap and lowercase.

If you press the F9 key while text is selected, the text will be formatted in proper title case, just as if you’d clicked “Make Selection Title Case” under the Editor’s ToolKit menu. You’ll find this a handy way to make a selection title case.

Access:

• F9

Lowercase a Word

Again, this feature lets you jump from word to word, this time lowercasing all the way. If you use it while text is selected, the text will be formatted in lower case. This is handy if you have several words in a row that need to be made lower case so you can apply small-cap character formatting.

Access:

• F10

This and the previous feature are especially useful when editing authors who are cap-happy. For example, let’s say you’re editing a manuscript in which the author has capitalized chapter headings like this: “CHAPTER ONE: THE GHOST IN THE MACHINE.”

Put your cursor on the first word, then press the F9 and F10 keys as needed—in this case, F9 four times, F10 twice, and F9 once again. Here’s the result: “Chapter One: The Ghost in the Machine.”

After you’ve practiced this a few times, you’ll be amazed at how easy and fast it is. Of course, you could always do the job with “Make Selection Title Case,” as explained above. But alternately using the F9 and F10 keys gives you more control.

Capitalize or Lowercase a Word (toggle)

Put your cursor anywhere on a word and click the toolbar button, and this feature capitalizes (initial cap) or lowercases the word and moves your cursor to the next word. That means you can jump from word to word, capping and lowercasing as you go. Incidentally, this function also turns a word in all caps to one that’s lowercase.

If you use this feature while text is selected, the text will be formatted in proper title case, just as if you’d clicked “Make Selection Title Case” under the Editor’s ToolKit menu.

Access:

• Editor’s ToolKit menu, Cap or Lowercase a Word


• Editor’s ToolKit 2 toolbar

Make a Word Italic or Roman (toggle)

This feature, too, jumps from word to word at the touch of a key, changing italic words to roman, and roman words to italic. It’s great when you’re editing authors who have forgotten to italicize book titles or who have italicized the titles of magazine articles. You can also use this feature to toggle italic on selected text.

Access:

•F8


• Editor’s ToolKit menu, Make Word Italic or Roman


• Editor’s ToolKit 2 toolbar [image: image5.png]



Transpose Words

Don’t you wish Word had a way to transpose words? Now it does. For example, you can turn “said she” to “she said” at the touch of a key. Place your cursor anywhere on the second of the two words you want to transpose. Then press F11.

Access:

• F11


• Editor’s ToolKit menu, Transpose Words


• Editor’s ToolKit 2 toolbar [image: image6.png]



Transpose Characters

One keystroke turns “rihgt” into “right.” Place your cursor between the two characters you want to transpose. Then press F12.

Access:

• F12


• Editor’s ToolKit menu, Transpose Characters


• Editor’s ToolKit 2 toolbar [image: image7.png]



Lock Pages

One of the main problems editors have working on a computer is that they lose their sense of proportion about the manuscript. What do I mean by sense of proportion? While working on a paper manuscript, with the pages piled neatly on the desktop, editors know exactly how much work they’ve done: 112 pages, stacked on the left, are finished; 204 pages, stacked on the right, are left to edit. In my experience, they also know that chapter 3 is about, oh, half an inch from the bottom in the left-hand stack if they need to go back to it. And they know, semi-consciously, that the odd foreign word the author used was about twenty pages back and about a third of the way down the page. In other words, they have a “positional memory” that helps them find things. It’s not as efficient as their word processor’s “find” function, but it’s not bad, either.

Editing on the computer throws all of this out of whack, because on the computer there are no discrete pages, just one long, solid mass of text that scrolls up and down. I know which “page” I’m on because Microsoft Word tells me the page number on its status bar. Still, when I fixed that misspelling, it was about half an inch from the top of the screen, but where is it now? And on what page? Who knows?

A fairly workable solution consists of “locking” the pages, using manual page breaks to separate that long string of text into discrete pages, each of which fits nicely inside of your screen, and setting the page length to its maximum of 22 inches. Then if you add or delete text on a page, the text won’t reflow over other pages (unless you’ve added more than 11 inches of text), which helps solve the positional-memory problem. Finally, Editor’s ToolKit sets the Page Dn and Page Up keys to go to the top of the page (like turning a manuscript page) rather than the next screen. All of this together makes a real difference in the “feel” of editing on the computer.

When you lock pages, the program sets the pages one line shorter than the height of your window. That means you should set the size of Microsoft Word’s window the way you want it before running the Lock Pages program. If you change the size of your window later, you can easily unlock the pages and then lock them again to fit the new window size.

Editor’s ToolKit plays fast and loose with such things as page size because it assumes that at this point in the publishing process you don’t really care about such things as page size or even point size because you are editing, not typesetting. Typesetting comes later in the publishing process. If you’re trying to do typesetting, copy fitting, or final formatting with Microsoft Word, you probably won’t want to lock or unlock pages.

Caution: If you’ve locked your pages, remember that they’re now 22 inches long, which means you probably don’t want to print them in that condition. Before printing, unlock your pages to return them to an ordinary 11 inches long.

Access:

• Editor’s ToolKit menu, Lock Pages


• Editor’s ToolKit 1 toolbar [image: image8.png]



Unlock Pages

Unlocking pages, as you might think, undoes what happens when you lock pages. It removes manual pages breaks and sets the page size to 11 inches.

Access:

• Editor’s ToolKit menu, Unlock Pages


• Editor’s ToolKit 1 toolbar [image: image9.png]



Prepare Documents for Editing

Before you work on documents in Editor’s ToolKit, there are certain things you’ll probably want to do to them. These things include applying the TYPESPEC template, locking pages, and turning on revision marking. To do these things in one fell swoop, click the Editor’s ToolKit menu, then click “Prepare Documents for Editing.”

The program will ask if you want to prepare the active document, all open documents, or all documents in a folder. If you need to prepare all documents in a folder, first copy them to a working folder called something like “Copy.” That will leave your original documents intact in case you need something to go back to. Also, make sure only the documents you want to prepare are in the Copy folder. Then you won't inadvertently prepare, say, some press-ready documents that you have spent many hours editing and formatting. Show all types of files to be sure.

In addition, make sure none of the documents is protected or read only. Editor’s ToolKit prepares your documents and then saves them. If the documents are protected or read only, the program will not work. You may also run into problems if your files need to be converted into Microsoft Word from a different word-processing format. Please make sure all of your files are in Microsoft Word format before running the program.

If you select the option to prepare all the documents in a folder, the program presents a dialog box that allows you to select the folder to which you have copied the documents to be prepared (leaving your original documents safe in their original folder). After you have selected the Copy folder, click the OK button or press ENTER to continue. On a Macintosh, click “Use Selected Folder.”

Finally, choose the options you’d like to use in preparing your documents. These include applying the TYPESPEC template, locking pages, turning on revision marking, and running FileCleaner.

Access:

• Editor’s ToolKit menu, Prepare Documents for Editing

Finish Edited Documents

Once you’ve finished editing your documents, you may want to delete annotations, unlock pages, turn off revision marking, and make revisions permanent. To do so, click the Editor’s ToolKit menu, then click “Finish Edited Documents.”

The program will ask if you want to finish the active document, all open documents, or all documents in a folder. If you need to finish all documents in a folder, first copy them to a working folder called something like “Copy.” That will leave your original documents intact in case you need something to go back to. Also, make sure only the documents you want to finish are in the Copy folder. Then you won't inadvertently finish, say, some press-ready documents that you have spent many hours editing and formatting. Show all types of files to be sure.

In addition, make sure none of the documents is protected or read only. Editor’s ToolKit finishes your documents and then saves them. If the documents are protected or read only, the program will not work. You may also run into problems if your files need to be converted into Microsoft Word from a different word-processing format. Please make sure all of your files are in Microsoft Word format before running the program.

If you select the option to finish all the documents in a folder, the program presents a dialog box that allows you to select the folder to which you have copied the documents to be finished (leaving your original documents safe in their original folder). After you have selected the Copy folder, click the OK button or press ENTER to continue. On a Macintosh, click “Use Selected Folder.”

Finally, if you’ve loaded FileCleaner, NoteStripper, and QuarkConverter as global templates (these programs are included with Editor’s ToolKit Plus), you’ll be able to run them. The program will automatically delete annotations, unlock pages, turn off revision marking, and make revisions permanent.

Access:

• Editor’s ToolKit menu, Finish Edited Documents

Add Documents

Often when I go to edit a book, I discover that the author’s chapters have been saved as individual documents. Depending on the book, I may decide to put all of these together in one long document, which makes it easier to make things consistent, find and replace items throughout the book, and so on. The “Add Documents” program makes it easy to bring a whole folder full of documents into a single document for editing.

To use the program, you must first make sure your documents are named alphabetically in the order in which they should appear, since that is the order in which the program will add them to your document. For example, you might name them something like this:

Chapter 01

Chapter 02

Chapter 03

. . .

Chapter 10

Chapter 11

And so on.

If you name them like this, you’ll have problems:

Chapter 1

Chapter 2

Chapter 3

. . .

Chapter 10

The documents will be combined in the wrong order, because your computer will see them in alphabetical order, like this:

Chapter 1

Chapter 10

Chapter 2

Chapter 3

If you open the folder in which the documents reside and list them alphabetically, they should appear in the order you want them. If they don’t, you’ll need to rename them so they do. Also, make sure no other documents are in the folder. If other files are there, they, too, will be added to the long document. Show all types of files to be sure.

When you’re ready to combine the documents, follow this procedure:

1. Create a new document on your screen or open an existing document to which you want to add the others.

2. Click the Editor’s ToolKit menu, then click “Add Files.”

3. Select the folder in which your documents reside.

The documents will be added, in order, to the active document, separated by manual page breaks.

Access:

• Editor’s ToolKit menu, Add Documents

Split Document

After I’ve edited a long document, such as a book, I sometimes split it up into smaller files by chapter, since I know that typesetters prefer working with smaller files in QuarkXPress. The Split Document program makes this easy to do.

Before running the program, make sure that your pages are unlocked, since the program will split the document at existing manual page breaks, and if your pages are still locked, you may have hundreds of these.

Once you’re sure that your pages are unlocked, insert manual page breaks (Ctrl + Enter) into your document at every point you want your document to be split. Do not, however, put a break at the top or bottom of your document.

Once you’ve marked the splits, click the Editor’s ToolKit menu, then “Split Document.” The program will copy each section into a new document and give the document a name that begins with the first four characters of the original document name followed by four digits, starting with 0001. For example, if your original document is named CHAPTERS, the split-off documents will have names like this:

CHAP0001

CHAP0002

CHAP0003

And so on.

The new documents will be saved in the same folder that holds your original document.

If you have QuarkConverter, you can prepare the individual documents for typesetting.

Access:

• Editor’s ToolKit menu, Split Document

Extend Selection

Extend Selection is a terrific Word feature you won’t find or even know about unless you really know where to look. I’ve made it accessible on what at first seems a strange place: the Insert key. I don’t like having the Insert key turn on typeover mode, which should always be turned off while editing and usually at all other times. (If you must use typeover mode, you can turn it on by double-clicking the “OVR” box in the status bar at the bottom of the screen. Just remember to turn it off again when you’re through.) Word also allows you to use the Insert key to paste text (see the Options menu), but I’ve found it too easy to hit the key accidentally and paste a bunch of unwanted text into a document without even knowing it. Thus, I’ve opted to use the Insert key for Extend Selection, and you’ll find that’s a handy key on which to have it.

Basically, Extend Selection turns on the selecting of text. Then you can use the cursor keys to move through the text, selecting as you go. The really neat thing for editing is that you can put your cursor at the beginning of the text you want to select, then activate Extend Selection, then type the character that’s at the end of the text you want to select. The selection will automatically jump to that character. I use this feature a lot to select to the period at the end of a sentence and to select to a carriage return at the end of a paragraph (in order to delete the selected text).

If you press the Insert key twice, you’ll select the current word. If you press it three times, you’ll select the current sentence. Press it four times to select the current paragraph, and five times to select all the text in the document.

To turn off Extend Selection without doing anything to the selected text, press the Escape key and then a cursor key.

Access:

• Insert key

Spike

Remember when editors wore green celluloid visors and impaled pieces of paper on a shiny steel spike? Word, too, has a spike, but it’s buried so deep that most Word users have never even heard of it. I’ve brought it up to the surface. The spike is a cumulative cut and paste. It lets you cut as many blocks of text as you like and then paste them all at once in your chosen location. The text is pasted in the order in which it was cut—first in, first out. If you’re rearranging massive chunks of text, you’ll like spike.

Note: Word’s spike feature has a bug: it pastes marked revisions as regular text, which means the text you’ve deleted comes back again along with the text you’ve added—just a mess. Editor’s ToolKit overcomes this problem by making permanent any revisions in the spiked text before it is pasted. Just so you know.

Access:

• Ctrl + F5 to spike


• Ctrl + F6 to paste the spike


• Editor’s ToolKit menu, Spike


• Editor’s ToolKit menu, Unspike


• Editor’s ToolKit 1 toolbar [image: image10.png]


 [image: image11.png]



Copy to Spike

Sometimes, rather than cutting text to the spike, you’ll want to copy text to the spike, leaving the existing text in place. When copying to the spike, however, there’s no way to allow for the bug described above under “Spike,” so be careful.

Access:

• Alt + Ctrl + F5 to copy to the spike (this is not listed on the keyboard template)


• Editor’s ToolKit menu, Copy to Spike


• Editor’s ToolKit 1 toolbar [image: image12.png]



Arrange Documents

With one keystroke, you can split your screen, arranging all open documents side by side—vertically, not horizontally. Then you can compare documents, cut from one and paste to another, and so on. Another keystroke puts your screen back to normal. I use this feature for heavy rewriting and rearranging. (To open two versions of the same document, under the Window menu select New Window.)

Access:

• Shift + Ctrl + F5


• Editor’s ToolKit menu


• Editor’s ToolKit 1 toolbar [image: image13.png]



In conjunction with this feature, you may want to use Word’s split-screen feature, which splits your document horizontally and lets you arrange the split to suit your needs.

Access:

• Shift + Ctrl + F7


• Window menu


• Editor’s ToolKit 1 toolbar [image: image14.png]



Mark and Find Your Place

Press Shift + F11 to mark the place you were editing. Move around the document to your heart’s content, or even to a completely different document. Press Shift + F12 to move back instantly to the place you marked. (If you’ve closed the document in which you last marked your place, the program will tell you what document it was.)

Access:

• Shift + F11 to mark


• Shift + F12 to find


• Editor’s ToolKit menu, Mark Editing Place


• Editor’s ToolKit menu, Find Editing Place


• Editor’s ToolKit 2 toolbar [image: image15.png]
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Go Back (Previous Edit)

“Go back” is another hard-to-find Word feature that I’ve made accessible. It takes you back to the last place you changed your document. Then the place before that. Then the place before that. In all, it will cycle through the last five places you made a change.

Access:

• Shift+ F10


• Editor’s ToolKit menu, Previous Edit


• Editor’s ToolKit 1 toolbar [image: image17.png]



Special Movement and Deletion Keys

Editor’s ToolKit provides movement and deletion keys that Microsoft should have provided but didn’t. It lets you:

Move to the end of the next word: Alt + Right Cursor

Move to the end of the previous word: Alt + Left Cursor

Move to the next sentence: Ctrl + Alt + Right Cursor.

Move to the previous sentence: Ctrl + Alt + Left Cursor.

Delete to the end of the line: Ctrl + Alt + End.

Delete to the beginning of the line: Ctrl + Alt + Home.

Delete a whole word no matter where your cursor is in the word (you won’t believe what a time-saver this is). You may not have noticed, but if you press Ctrl + Delete in ordinary Microsoft Word, you’ll delete not the whole word but only the portion of the word to the right of the cursor. That means to delete a whole word, you have to move your cursor to the beginning of a word (unless it’s already there), which is a nuisance. With Editor’s ToolKit, you can place your cursor anywhere in a word and delete it by pressing Ctrl + Delete. I predict that you will love this feature. If you need to delete only part of a word, Alt + Delete will delete to the right of the cursor, Alt + Backspace to the left of the cursor.

Ordinarily in Word, when you press Page Up or Page Down, you’ll move one screen up or down but your cursor will stay on the same line. For example, if you’ve just finished editing a screenful of text and you move down to the next screen, the cursor will still be at the bottom of the screen rather than at the top where it should be. Editor’s ToolKit fixes this problem. If, however, for some strange reason you actually want your cursor to stay at the same position while moving up or down a screen, press Alt + Page Up or Alt + Page Down.

Keys for Special Characters

With Editor’s ToolKit, you can insert em dashes, en dashes, and bullets with simple key combinations or the mouse. No more picking your way through Word’s symbol charts.

Access:

• Alt + m for em dash


• Alt + n for en dash


• Alt + b for bullet (followed by a space)


• Insert menu


• Editor’s ToolKit 2 toolbar [image: image18.png]
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• Shift + F2, F3, or F4

The Mouse as Pencil

I love editing in Microsoft Word, but for a long time I missed being able to just put my pencil on a word, as I could on a paper manuscript. I grew tired of laboriously “cursing” through a page (sometimes literally) with the cursor keys, using dozens of keystrokes in the process. Then I realized I had an electronic pencil—the mouse. I just needed to make it do most of the things a pencil can do: delete, capitalize, lowercase, italicize, transpose, and so on. I already had all those features in Editor’s ToolKit, so it was a simple matter to put them on the text shortcut menu accessible from the right mouse button.

Now I often use the mouse to move around a document. When I see a word I want to delete (for example), I point to it with the mouse, click the right mouse button, and click Delete Word on the shortcut menu. Presto! The word is gone.

With some experimentation, I’ve learned which features I use most with the mouse, and those are the ones I’ve placed on Word’s text shortcut menu. Here they are:

Delete (a single character or text you’ve already selected with the mouse)

Delete Word

Add to Spike

Insert Spike

Cap or Lowercase Word (toggle)

Make Word Italic or Roman (toggle)

Transpose Characters

Transpose Words

Apply Heading 1 Style

Apply Heading 2 Style

Apply Heading 3 Style

Apply Heading 4 Style

AutoStyle Block Quotation

AutoStyle List

AutoStyle Poem

Word already includes cut, copy, and paste on the right mouse button. Also, don’t forget that Word allows you to select, drag, and drop text using the mouse. (Clicking twice selects a word; thrice, a paragraph.) Using all those features, you’ll be amazed at how much editing you can do without ever touching the keyboard. (One trick is to copy and paste a word from nearby text rather than typing it in.) And, of course, all of the menu and toolbar functions are accessed with the mouse. With a little practice, you’ll probably agree that the mouse makes a pretty good pencil.

Marking Type Specs

When editing on paper, you probably mark type specs by writing A, B, or C next to headings, writing “Block” next to block quotations, and so on. You can do the same thing in an electronic manuscript by using styles. For example, you can mark a main heading level by applying the style Heading 1.

Of course, styles do more than just mark levels of type. They also apply formatting to those levels. Applying Heading 1, for example, might format a heading with 24-point Arial. I’ve heard people ask, “Why not just mark each heading as 24-point Arial? Why bother with styles?” If this is a question you might ask, you’re about to increase your productivity. The beauty of styles is that they allow you to change your mind. Let’s say you’ve marked all of your main headings—102 of them, to be exact—as 24-point Arial, but your client thinks they should be bigger—32 points instead of 24. You now have the painful task of selecting and reformatting every single one of those 102 headings—unless, of course, you’ve used styles, in which case you can change the heading style with a few clicks of the mouse, automatically changing all 102 headings.

Using styles provides some other advantages, too:

1. You can easily find one style and replace it with another, using Microsoft Word’s find and replace feature. This is much simpler than having to search for directly applied formatting, such as 24-point Arial bold no indent.

2. If you’ve used Word’s built-in heading styles (Heading 1 through Heading 9), you can see and change the structure of your document in Word’s Outline view. These headings can be applied from the styles window or the headings buttons (1, 2, 3, and so on) on the Editor’s ToolKit 3 toolbar but also from the keyboard by holding down Ctrl + Shift and pressing one of the number keys (1 through 9). (Incidentally, Ctrl + Shift + N applies the Normal style.) I generally use Heading 1 for part titles, Heading 2 for chapter titles, and Heading 3 for subheads in a chapter.

3. Styles can be retained when importing a document into QuarkXPress, picking up the formatting specified for those styles in the QuarkXPress style sheets. This also makes it possible to quickly and easily change formatting globally in QuarkXPress just by changing the style sheets. If you’re a typesetter and you’re not using style sheets, you’re spending a lot more time on formatting than you need to, and you’re missing much of the power of QuarkXPress.

The Typespec Template

Included with Editor’s ToolKit is a template containing various styles with which you can mark spec levels in a manuscript. The name of the template is TYPESPEC.DOT, and it should reside in your Word templates folder.

Whenever you prepare a document for editing in Editor’s ToolKit, the TYPESPEC template is applied to it, if you so command. If you decided you didn’t want it applied but later change your mind, you can make the template available to the document you’re working on by following this procedure:

1. Click the Format menu.

2. Select Style Gallery.

3. Scroll down the list of templates until you see TYPESPEC.

4. Click on TYPESPEC.

5. Click OK.

All of the styles in the TYPESPEC template should now be available.

You can access the styles in the TYPESPEC template by selecting Styles under the Format menu or by pressing the F5 key, but an easier way is to select them from Editor’s ToolKit 3 toolbar, in the Styles window at the left of the toolbar.

If you’re going to mark a single paragraph, just put your cursor anywhere in the paragraph, then select the style from the list in the window. If you’re going to mark more than one paragraph, first select the paragraphs you want to mark, then select the style.

The TYPESPEC template uses mainly the Verdana typeface, which was created especially for viewing on-screen. Verdana lends itself well to editing because of its legibility and because its quotation marks and dashes are easily distinguishable. Another typeface that works well for editing is Georgia, which, unlike Verdana, has serifs. Both fonts are available as free downloads from the Microsoft website, to which I’ve provided links on the Editorium website (on the Editor’s ToolKit page).

You may wonder why none of the styles in the TYPESPEC template uses bold or italic formatting. The reason is that using character formatting, such as bold and italic, is the editor’s prerogative for marking emphasis in text. Even a short heading marked with Heading 1 may have one or more individual words marked with italic for emphasis. For that reason, I’ve left the use of bold and italic up to you rather than trying to impose it upon you.

Please note that you can change the formatting of the Typespec styles any way you like. Also, you don’t have to use the TYPESPEC template for Editor’s ToolKit to work. Feel free to use any document templates you like.

Special Styles

Most of the styles in the TYPESPEC template are easy to understand, but a few require special comment. You’ll notice that the Normal style has been renamed to Normal,Text 1. That’s so you can later typeset your text in QuarkXPress, which, like Word, uses a default style called Normal and thus won’t work easily with Word’s Normal style.

Some of the styles end in “NI,” which stands for “no indent.” Use these to mark text that should have no paragraph indent. For example, use Block Quote Start NI to mark the first paragraph of a block quotation that begins somewhere in the middle of the paragraph you are quoting. Use Normal Text 1 NI after a block quotation to mark text that does not begin a new paragraph but continues the thought of the text before the block quotation. Using these styles is the equivalent of writing “No paragraph” or “No indent” on a paper manuscript.

After you have marked a paragraph with one of the “NI” styles, you’ll need to be sure the following paragraph is marked with a different style, or it, too, will have no indent. For example, if you’re marking a block quotation that contains two paragraphs, you might mark the first paragraph with Block Quote Start NI and the following paragraph with Block End (which does include a paragraph indent).

Here’s an example of the whole process:

____________________________________________________

Needing advice on how to handle the indenting of a block quotation, Jill found these guidelines in The Chicago Manual of Style, sections 10.20 and 10.25:

If the quotation includes the beginning of the opening paragraph, it should start with a paragraph indention. If the first part of the paragraph is omitted, the opening line ordinarily begins flush left (not indented). . . .

If, following an extract or block quotation, . . . the resuming text is a continuation of the paragraph that introduces the quotation, the resuming text should begin flush left. If the resuming text is a new paragraph, it should be given regular paragraph indention.

Agreeing completely with this analysis, Jill decided to follow it to the letter as she began editing the massive tome.

____________________________________________________

In this example, the first paragraph is marked with Normal,Text 1. The second paragraph (the first paragraph in the block quotation) is marked with Block First NI. The third paragraph (last in the block quotation) is marked with Block Last. The final paragraph is marked with Normal,Text 1 NI.

The reason for using the First and Last styles is so that the leading above, between, and after the paragraphs comes out right. In addition, if the block quotation above had contained four paragraphs, the second and third would have been marked with Block Middle.

I hate to mention what you have to do to mark poetry, but I will, in this little two-stanza “poem” made up of style names:

Poem First NI

Poem Middle

Poem Middle NI

Poem Middle

Poem Middle NI

Poem End

Poem Start NI

Poem Middle

Poem Middle NI

Poem Middle

Poem Middle NI

Poem Last

Marking the poem in this way allows you to use different leading before the poem, between stanzas, and after the poem, and it also allows you to adjust the indentation of each line, or even to use no indentation. Applying all those styles seems like a lot of work, but if you were editing the poem on paper, you’d basically have to do the same thing by marking line indents, extra leading, and so on.

AutoStyler™

All of this marking has to be done by somebody at some point and in some way. “Too much work,” you say? That’s why I’ve included the AutoStyler feature with Editor’s ToolKit. AutoStyler makes it possible to select, say, a block quotation and instantly style it as it should be, with the first, middle, and last paragraphs all styled differently. The AutoStyler functions are available on the Editor’s ToolKit menu (under AutoStyles), on the Editor’s ToolKit 3 toolbar, and on the keyboard by pressing Ctrl + Shift and B (for block), L (for list), or P (for poem). They include:

1. The Block AutoStyler, for block quotations.

2. The List AutoStyler, for lists.

3. The Poem AutoStyler, for poetry.

To use an AutoStyler function:

1. Select the text you want to style. For example, if you want to style a block quotation, you’d select all of the paragraphs that make it up.

2. Click the applicable AutoStyler menu item, button, or key combination. For example, if you want to style a block quotation, you’d click the Block (“B”) button.

The text will be styled as it should be.

When you’re using the Poem AutoStyler, your poem can have carriage returns separating the stanzas. The Poem AutoStyler will take the carriage returns (stanza breaks) into account, style the preceding lines with the style Poem End Stanza, and delete the carriage returns.

If you’re a typesetter who has been marking such styles manually, AutoStyler will make you smile.

For the AutoStyler functions to run, the following styles (used in the TYPESPEC template) must exist in the active template. If they don’t, AutoStyler will create them:

Block (designates a single-paragraph block quotation)

Block First (designates the first paragraph of a multiple-paragraph block quotation)

Block Middle (designates any middle paragraph of a multiple-paragraph block quotation)

Block Last (designates the last paragraph of a multiple-paragraph block quotation)

List (designates a single-paragraph list, if there is such a thing)

List First (designates the first item in a multiple-paragraph list)

List Middle (designates any middle item in a multiple-paragraph list)

List Last (designates the last item in a multiple-paragraph list)

Poem (designates a single-line poem, if there is such a thing)

Poem First NI (designates the first line of a poem, not indented)

Poem Middle (designates a middle line of a stanza)

Poem Middle NI (designates a middle line of a stanza, not indented) 

Poem Start NI (designates a line that begins a stanza, not indented)

Poem End (designates a line that ends a stanza)

Poem End NI (designates a line that ends a stanza, not indented)

Poem Last (designates the last line of a poem)

Poem Last NI (designates the last line of a poem, not indented)

Making a Style Sheet

If someone else (like a designer or typesetter) needs to know the names of the styles you’re using in a certain project, you can easily provide them by making a style sheet. To do so:

1. Open some documents from the project that contain all of the styles you’re using.

2. Under the Editor’s ToolKit menu, select Make Style Sheet.

The program will create a new document that includes the styles and the names of the styles in all open documents. You can print this new document or give it to someone else in electronic form.

Editing with Editor’s ToolKit

Ordinarily, when I edit a document with Editor’s ToolKit, I follow this procedure:

1. I back up my documents so I’ll have the originals to go back to if the need arises.

2. I use the Prepare Documents for Editing feature to run FileCleaner and apply the TYPESPEC template.

3. I apply styles to headings, block quotations, and so on.

4. I use the Prepare Documents for Editing feature to lock pages and turn on revision marking.

5. I edit the documents, using the various features of Editor’s ToolKit and Microsoft Word. I especially use the features that are accessible with the function keys, such as capping and lowercasing words, transposing words and characters, italicizing words, showing and stetting revisions, and so on. The function keys make all of these features a true pleasure to use. (When I’m feeling particularly lazy, however, I use the features on the right mouse button.)

6. I use the Finish Edited Documents feature to unlock pages, turn off revision marking, make revisions permanent, and run NoteStripper and QuarkConverter.

7. I give the finished documents to the typesetter.

For me, Editor’s ToolKit makes editing fast, easy, and efficient. After three years of using it, I can’t imagine working without it. I hope you enjoy it as much as I do.

FileCleaner

Thank you for using FileCleaner for Microsoft Word!

Have you ever wished you could quickly and easily clean up common typographical problems in a manuscript without tediously finding and replacing each one? FileCleaner lets you do just that, replacing double spaces with single spaces, changing double returns to single returns, turning underlining to italic, fixing spacing around ellipses, and so on. FileCleaner will save you hours of time while improving the typographical quality of everything you write or edit.

FileCleaner is especially useful to people who are preparing text for typesetting and are using Microsoft Word as a "front end" for such programs as QuarkXPress, PageMaker, or FrameMaker. Editors and typesetters will find it invaluable, and this documentation is geared primarily to them. FileCleaner is also an excellent tool for desktop or electronic publishing, and writers will appreciate being able to clean up common manuscript problems in one fell swoop.

Running FileCleaner

Before running FileCleaner, be sure to back up your documents in case you later change your mind. In addition, try using FileCleaner on some test files until you understand how it works and what it does. Then you'll be prepared for the real thing.

You can use FileCleaner to clean up documents in two different ways:

1. One item at a time. You can do this by clicking the buttons on the FileCleaner Toolbar, which you can activate by selecting Toolbars under the View menu and clicking the FileCleaner checkbox. This is handy for cleaning up problems as you come across them while editing a document. Please note that this type of cleanup affects only the part of the document you are in. For example, if you are in a footnote panel, it will clean up the footnotes. If you are in the main text, that is what will be cleaned up.

2. All items (or several selected items) at once. Do this by selecting FileCleaner under the ETKPlus menu or by pressing the FileCleaner button at the left of the Toolbar. This option is useful for cleaning up all problems at one time. It is very powerful and is probably the one you will use the most. This type of cleanup affects the main text in a document, footnotes and endnotes, and (on a PC but not a Macintosh) headers and footers. It does not, however, clean up annotations.

When you run FileCleaner to clean up all items at once, the program asks if you want to clean up the active document, all open documents, or all documents in a folder. Select the option that suits your needs.

Cleaning Up All Documents in a Folder

Before cleaning up all documents in a folder, copy them to a working folder called something like “Copy.” That will leave your original files intact in case something goes wrong. Also, make sure only the files you want to clean up are in the Copy folder. Then you won't inadvertently clean up, say, some press-ready files that you have spent many hours editing and formatting.

In addition, make sure none of the files is protected or read only. FileCleaner cleans up the files and then saves them. If the files are protected or read only, FileCleaner will not work. You may also run into problems if your files need to be converted into Microsoft Word from a different word-processing format. Please make sure all of your files are in Microsoft Word format before running the program.

If you select the option to clean up all the documents in a folder, FileCleaner presents a dialog box that allows you to select the folder to which you have copied the files to be cleaned (leaving your original files safe in their original folder). After you have selected the Copy folder, click the OK button or press ENTER to continue.

When FileCleaner is finished and you have looked through the files to be sure they are cleaned up correctly, you can move them from the Copy folder to your original folder.

Selecting Items to Clean Up

The program will show you a list of items you might want to clean up, and you can check the ones you want to use. Please note the two boxes at the bottom that allow you to clear or select all the items on the list. Also note that the items will be cleaned up in the order in which they appear on the list. This is important because some items will not be cleaned up correctly unless other items have been cleaned up first. For example, you can't dependably clean up spacing around ellipses without first cleaning up multiple spaces. (Also keep this in mind when cleaning up individual items with the toolbar buttons.)

When you are finished selecting the items you want to clean up, click the OK button. FileCleaner will do the job as you requested. When it is done, it will display a message saying "Finished!" Click OK, then review your cleaned-up documents. If you change your mind, go back to the original files.

Other Considerations

You may want to run FileCleaner twice: once before you begin editing, and once before you are ready for typesetting or final formatting. Please read the sections entitled "Remove Font Formatting," "Remove Paragraph Formatting," and "Remove Style Formatting" under FileCleaner Options, below, before doing so, however.

Please note that FileCleaner turns off both viewing and marking of revisions while it works.

FileCleaner Options

Here are the various cleaning options FileCleaner provides:

Put Abbreviations in Small Caps

This option puts A.M., P.M., B.C., A.D., B.C.E., and C.E. into small caps, which is how they should appear typographically. Please note that if you abbreviate “chief executive officer” as C.E.O. (with periods) rather than CEO (without periods), this option will put the C.E. into small caps.

Change Underlining to Italics

This option changes text that is underlined into text that is italicized. In the days before word-processing, people used typewriter underlining to indicate text that was to be set in italics. Some writers, even though they are now composing on computer, still continue in that tradition. Underlining, however, should not ordinarily be used in typesetting, and this option allows you to turn it into italics as it should be.

Change Raised Text (3 Points) to Superscript

This option changes text that is raised by three points into superscript. The point of this is that Word documents that have been converted from WordPerfect often have footnote numbers that are raised rather than superscript. This option fixes the problem.

Delete Extraneous Tabs

The proper way to set paragraph indentation is with formatting in a style, not with a tab. That means all tabs at the beginnings of paragraphs should be deleted. This option does the trick. It also replaces multiple tabs inside paragraphs with single tabs so tabular formatting can be done correctly by adjusting tab settings. Warning: If an author has used tabs to do specialized formatting of tables or diagrams, you'll want to use this option with caution.

Replace Multiple Spaces with Single Spaces

Your high-school typing teacher probably told you to put double spaces after the end of each sentence to make your typing "easier to read." Actually, this is a typographical abomination that must be cleaned up before a document is typeset. This option turns any combination of spaces into one space. Warning: If an author has used spaces to do specialized formatting of tables or diagrams, you'll want to use this option with caution.

Delete Spaces around Returns

Spaces around carriage returns are invisible to the eye, but they cause various typographical problems. This option gets rid of them. Because Word does not permit the deletion of returns after footnotes and endnotes, this option does not work with notes.

Replace Multiple Returns with Single Returns

Ordinarily, the proper way to set extra leading between paragraphs or after headings is with formatting in a style, not with extra carriage returns. This option turns any combination of returns into a single return. Because Word does not permit the deletion of returns after footnotes and endnotes, this option does not work with notes. Warning: If an author has used multiple returns to indicate special formatting, you'll want to use this option with caution.

Fix Spacing around Ellipses

Authors have numerous ways of typing ellipses. Some use the horrid little ellipses "character" available in some symbol fonts. Others type three periods in a row with no spacing in between. And there are many other variations. This option fixes them all, with three periods separated by spaces. (The spaces after the first two ellipsis points are nonbreaking so the ellipsis points won't break at the end of a line.)

Change Straight Quotation Marks to Curly Ones

If you are editing a file that contains "straight," old-fashioned quotation marks and apostrophes as found on a typewriter, you can turn them into typographically correct "curly" marks by using this option, which will also activate Word's Autoformat option of turning straight quotation marks to curly ones as you type.

This option also turns single quotation marks at the beginning of certain words into apostrophes. These words are ’til, ’tis, ’tisn’t, ’twas, ’twasn’t, ’twould, ’twouldn’t, and ’em. The same is true of single quotation marks in front of numbers, such as ’99. Except for these exceptions, this option will turn apostrophes at the beginning of words into single quotation marks, which is almost always what they should be.

There is also a macro that does precisely the opposite of this option, turning curly marks into straight ones and turning off the Autoformat option. Its name is FixCurlyQuotationMarks. You can run it under Tools, Macros, and you'll find it especially useful if you are creating Help files.

Fix Commas and Periods outside Quotation Marks

Typographically, commas and periods should be "inside" (to the left of) closing quotation marks. Why? Because they look funny hanging out there all by themselves. This option puts them where they belong.

Fix Punctuation Marks outside Italics

Punctuation should usually be typeset in the character style of the text that precedes it. For example, if a word set in italic type is followed by a question mark, the question mark, too, should be set in italic type. This option makes it so for periods, commas, colons, semicolons, question marks, and exclamation points.

Change Double Hyphens to Em Dashes

Em dashes are used for various purposes, such as setting off an illustrative element from the rest of the sentence. Many authors use double hyphens to indicate em dashes--like this. This option turns each set of hyphens into the dash it should be.

Change Hyphens between Numerals to En Dashes

En dashes are used primarily to indicate inclusive numbers, as in an index. Many authors use hyphens to serve the same purpose, like this: 145-46. This option changes those hyphens into typographically correct en dashes.

Delete Spaces around Dashes

Some authors think it looks nice to leave spaces around both em and en dashes. It doesn't. This option removes those spaces.

Change Ells Used as Ones to Ones

Remember when typewriters didn't even have a character for the numeral one? The ell did double duty, probably to keep the number of keys to a minimum. Now, decades later, some authors still type ells for ones, creating a typographic nightmare. This option fixes all such problems while leaving the real ells intact.

Change Os Used as Zeroes to Zeroes

This problem is similar to the previous one. Some authors type an O when they should type a zero, but typographically the two characters are not the same. This option fixes the mistake.

Remove Font Formatting

Authors often go to great lengths to format their documents using various fonts, point sizes, paragraph formats, and so on. What they don't realize is that such formatting, nice as it may look to them, is nowhere near the look you or your designer will specify. In fact, their formatting usually just gets in the way, making editing and typesetting more difficult than it should be.

This option removes all directly applied font formatting, such as Times New Roman 12 point. However, it retains certain character formatting (bold, italic, underline, word underline, superscript, subscript, small caps, all caps, strikethrough, and hidden) as well as paragraph styles, such as Normal and Heading 1. This leaves you with a document in which you can modify the paragraph styles to format the document properly.

Remove Paragraph Formatting

This option removes all directly applied paragraph formatting, such as Centered or Justified, again so you can adjust paragraph formatting by modifying styles.

Remove Style Formatting

This option applies the Normal style to the entire document, wiping out any other paragraph styles. Warning: If an author has used styles properly to mark various text levels, you may not want to use this option. Also, if you have used styles to format a document and want to retain them, do not use this option.
NoteStripper

Thank you for using NoteStripper for Microsoft Word!

NoteStripper provides a variety of tools for working with notes. Using NoteStripper, you can:

1. Strip Word’s embedded, automatically numbered footnotes or endnotes to the bottom of a document (or section) as numbered text, replacing the note reference numbers in the text with superscript numbers. (This is especially useful if you need to import a document with notes into a typesetting program, such as QuarkXPress or PageMaker, without losing character formatting, such as italic.) You can also strip them inline with any typesetting codes you specify for use in such programs as Ventura or Kytek’s fXT Quark XTension.

2. Strip text notes at the bottom of a document into embedded footnotes or endnotes.

3. Strip embedded footnotes or endnotes into parenthetical text.

4. Strip parenthetical text into embedded footnotes or endnotes.

NoteStripper also includes various utilities to make working with notes easier.

This version of NoteStripper (3.00) includes several enhancements and fixes over previous versions:

1. The ability to strip notes to or from the ends of sections.

2. The ability to include tags around notes and to strip them inline for use in such typesetting programs as Corel Ventura, TeX, and fXT, with great flexibility in specifying tags and placement.

3. The ability to turn inline, tagged notes into embedded notes.

4. The use of Footnote Reference and Endnote Reference character styles (rather than just superscript) to format note numbers when stripping notes to text.

5. The addition of two new note formats: (1) tag, number, tag (for better number alignment), and (2) en space, number, en space (for traditional typographical alignment).

6. The true deletion of notes that were deleted during editing with Revision Tracking on, which a bug in Word otherwise prevents from being deleted.

7. The preservation of numbers that begin the text of a note (“1999 was a good year . . . ). In previous versions, these were seen as part of the note number being stripped and were thus deleted.

I strongly recommend that you try NoteStripper several times on a variety of test documents until you understand fully how it works and what it can do. Also, before running NoteStripper at any time, be sure to back up your documents. That way, you’ll have something to go back to if you’re not satisfied with the results.

You shouldn’t use this version of NoteStripper with my Editor’s ToolKit Plus program, which includes an earlier version of NoteStripper and may not work properly if you try to use both programs at once. To avoid the problem, just temporarily turn off Editor’s ToolKip Plus.

By using NoteStripper, you accept the terms of agreement found at the end of this document. The first time you run NoteStripper, the terms of agreement will appear on your screen. Please read them carefully. If you accept the terms, you will be able to use the program. If not, you will not be able to use it.

Global Templates

NoteStripper is basically a collection of macros in a template. You don’t use this template as you would an ordinary template by attaching it to a document. If you try to do that, you’ll run into problems. Instead, you “add” it to Microsoft Word as a global template or add-in (see installation instructions below).

Because the template contains macros, some virus-checking programs or even Word itself may warn you that the template could contain Word viruses. Please rest assured that it does not. The macros have been carefully checked and tested to make sure they are safe and usable. If you have any question about this, you can download the program from my Web site at www.editorium.com. You may need to adjust Word’s macro security settings so that the macros in the program can operate. If Word asks if you want to “enable macros” when using this program, your answer should be yes. Otherwise, the program won’t work. Please see your Word documentation for more information.

Stripping Notes to Text

You may know that it is possible to turn embedded notes into text simply by saving a document in text format. A disadvantage of doing so is that all character formatting is lost. Because notes typically contain lots of book titles in italic, this is a serious problem—thus the need for a program that will strip embedded notes to text while leaving their formatting intact.

NOTE: If you’ve used Word’s Revision Tracking feature in your documents, you’ve probably noticed that Word has a bug that prevents it from actually deleting notes when Revision Tracking is turned on. The notes are marked as deleted in your document text, but if you open the notes pane and look, they’re still in there. NoteStripper will actually delete such notes before proceeding. If it didn’t, these semi-deleted notes would cause problems. NoteStripper will, however, leave your other tracked revisions intact.

To strip notes to text, click the NoteStripper menu under the ETKPlus menu. Then click “Notes to Text.”

NoteStripper will ask which documents you would like it to work on:

1. The active document.

2. All open documents.

3. All documents in a folder.

Choose the option that fits your needs.

Stripping All Documents in a Folder

If you need to strip notes from all documents in a folder, first copy them to a working folder called something like “Copy.” That will leave your original documents intact in case you need something to go back to. Also, make sure only the documents you want to strip are in the Copy folder. Then you won’t inadvertently strip, say, some press-ready documents that you have spent many hours editing and formatting. Show all files to be sure.

In addition, make sure none of the documents is protected or read only. NoteStripper strips your documents and then saves them. If the documents are protected or read only, NoteStripper will not work. You may also run into problems if your files need to be converted into Microsoft Word from a different word-processing format. Please make sure all of your files are in Microsoft Word format before running the program.

If you select the option to strip all the documents in a folder, NoteStripper presents a dialog box that allows you to select the folder to which you have copied the documents to be stripped (leaving your original documents safe in their original folder). After you have carefully selected the Copy folder (don’t get the wrong one!), click the OK button or press ENTER to continue.

NoteStripper strips out notes in order from the beginning to the end of a document. That means if all of your chapters are in one section in a long document, the notes will be stripped and numbered consecutively throughout the document and not within each individual chapter. If you want your notes to be numbered starting with 1 in each chapter, you’ll need to separate your chapters with section breaks or put each chapter into an individual document.

NoteStripper Options

After letting you choose the documents you want to work on, NoteStripper presents you with certain options about how it will run.
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Notes to Strip

The first option lets you choose the type of note to strip:

1. Footnotes.

2. Endnotes.

3. Both footnotes and endnotes. Most of the time, this is the option you’ll want to use.

If you choose both footnotes and endnotes, NoteStripper will convert your endnotes to footnotes and then strip all of the notes together. If you try to strip footnotes first and then strip endnotes later, you’ll end up with duplicate note numbers in your document, which you don’t want. I’ve included the option to strip footnotes or endnotes separately, however, for the day when, for some reason, you need to do so. If I know publishing, that day will come sometime.

To Location

The second item lets you specify the location where you want the notes to go. You can place them in these locations:

1. End of document or section. If your document doesn’t have sections, this option will correctly strip notes to the end of your document. Otherwise, it will strip them to the ends of the sections containing the notes.

2. End of document only. This option strips notes only to the end of the document and not to the ends of sections. If your document has sections and you’re planning to re-embed the notes later, don’t use this option. If you’re going to get rid of section breaks later, and you really do want all notes at the end of the document, this is the option to use.

3. Inline before reference number.

4. Inline after reference number.

“Why,” you might ask, “would I want to place my notes inline?” You may need such an option if you’re stripping notes to text so you can import them into certain typesetting programs. Corel Ventura, for example, needs to have notes inline. Kytek’s fXT XTension for QuarkXPress also works best if notes are stripped inline before the reference number. For more information, consult the documentation for your typesetting program.

There are two last options here: “Number by section” and “Include carriage returns.”

Number by Section. If you select “Number by section,” NoteStripper will restart note numbering at 1 for each section rather than numbering notes consecutively.

Include Carriage Returns. If you’re stripping notes to the end of the document, you’ll almost always want to include carriage returns. In fact, if you choose the option to strip notes to the end of the document or the ends of sections, the option to include carriage returns is automatically checked, even if you previously unchecked it for some other option. If you want it off, you can turn it off, but you’ll have to work at it. Someday you’ll thank me for making it hard. If this option is checked and you’re stripping notes to the end of the document, NoteStripper will simply include the carriage return that came at the end of each note—thus preserving the paragraph style of the note (such as Footnote Text). If you’re stripping notes inline, NoteStripper will still include that carriage return, but it will also insert an additional carriage return at the beginning of each note. If you need to customize this further (such as including a carriage return at the beginning but not at the end of an inline note), turn this option off and include carriage return codes with your notes as explained below under “Codes.”

Note Number Format

The third item lets you choose the style of note numbering to use in the extracted notes:

1. A number followed by a period and a space.

2. A number followed by a period and a tab.

3. A superscript number followed by a space. (“Superscript” here actually means the Footnote Reference or Endnote Reference character style, however it’s formatted.)

4. A superscript number. (“Superscript” here actually means the Footnote Reference or Endnote Reference character style, however it’s formatted.)

5. A number preceded by a tab and followed by a period and a tab. (This option makes it possible to align note numbers on the tabs.) NOTE: If you’re planning to re-embed your notes later (see “Stripping Text to Notes,” below), don’t use this option. Instead, use option 1, 2, 3, or 4.

6. A number preceded by an en space and followed by a period and an en space (the traditional typographical way of setting note numbers in a list). If you have less than ten notes, no en space will be added. If you have ten or more notes, the appropriate number of en spaces will be added to align all of your note numbers properly. NOTE: If you’re planning to re-embed your notes later (see “Stripping Text to Notes,” below), don’t use this option. Instead, use option 1, 2, 3, or 4.

Other numbering options, such as letters, Roman numerals, and special characters, are not available.

Codes

If you like, you can add typesetting codes to your notes so they can be imported into programs like Corel Ventura, fXT, and TeX. Your options are:

1. Include codes. Instructs NoteStripper to include codes. It also makes available the other coding options below.

2. Hide codes. Hides the codes around the notes so that if you’re adding other typesetting codes, the note codes won’t get in the way. For example, the Editorium’s QuarkConverter program can insert a Quark XPress tag that will prevent a hyphenation break on the last word in a paragraph. This tag would not work properly, however, if it was inserted in the middle of a note code. So NoteStripper gives you the option to hide these codes in case you have other processing to do that might affect them. It hides them simply by formatting them with Word’s Hidden formatting (Format > Font > Hidden).

3. Omit reference number. Some typesetting programs, such as Corel Ventura, don’t need a reference number included with note coding. This option allows you to leave it out.

4. Omit note number. Some typesetting programs, such as Corel Ventura, don’t need a note number included with note coding. This option allows you to leave it out.

Under these options are text boxes where you can insert the codes you need to include with your notes. You can include:

1. Codes before the reference number.

2. Codes after the reference number.

3. Codes before the note.

4. Codes after the note.

To include the codes you need, type them into the appropriate boxes. You can also leave a box or boxes blank. You can include a paragraph code and a counter code (as defined by NoteStripper) in each box. (You cannot use the paragraph code in the document itself, or NoteStripper will convert it into a carriage return.)

The paragraph code is:

||p||

This code tells NoteStripper to insert a carriage return at the point where you include the code.

The counter code is:

||c||

NoteStripper will insert an incremented number at the point you insert one of these codes, starting with 1 and ending with the number of your last note (for the document or section, depending on your settings). For example, if you have 15 notes, the counter would start with 1 and end with 15. Here’s an example of the codes needed before and after an inline note with Kytek’s fXT XTension for QuarkXPress, showing the counter code in use: 

[[FR f||c|| M=20p]]

[[E f||c||]]

In the document itself, NoteStripper would enter the following actual codes for note 7 (for example):

[[FR f7 M=20p]]

[[E f7]]

After you’ve set your options and entered any codes you need, click “OK” to have NoteStripper strip out the notes. If there are lots of them, it may take awhile, so please be patient. When NoteStripper is finished, it will let you know.

Please note that NoteStripper turns off marking of revisions while it works.

Stripping Text to Notes

Stripping text to notes means transforming text notes at the end of a section or document into “embedded” Word footnotes or endnotes—the kind you get by clicking the “Insert” menu, clicking “Footnote,” and clicking the other note options you want to use. Embedded notes are easy to edit because they automatically renumber—you don’t have to change note numbers by hand if you delete notes or add them. In addition, if you have a mass of typed notes that are misnumbered, stripping text notes to embedded ones numbers the notes consecutively as they should be.

Definitions

To keep things clear, here are definitions for several terms that are used often in the instructions that follow:

Body text: The main text of your document.
Note reference: A superscript character in body text that refers to a note.

Note: A footnote or endnote.

Note number: The number at the beginning of a note. (Not to be confused with a note reference.)

Note text: The text of a footnote or endnote.
Here is a sample “document” that contains all of these elements:

This is body text, followed by a note reference.1
1. This is a note. It begins with a note number and contains note text.

Rules for Stripping Text to Notes

Before stripping text notes to embedded notes, you must make sure your document follows certain rules:

1. It must have the same number of notes and note references. If the number of notes and references appears to be different, the program will tell you, and you’ll have to fix the problem before the program will run. The problem may be that some of your note references are formatted as raised rather than superscript, so NoteStripper doesn’t see them as references. Or, you may have a space or tab in front of some of your notes. If so, NoteStripper won’t see them as notes and so won’t count them. Another possibility is that whoever typed the note numbers (not references) sometimes used ells for ones. If a note has more than one paragraph, and one of those additional paragraphs starts with a number [“1999 was a good year . . .”], NoteStripper will see it as a note number, which will also mess up your count, so you’ll need to edit such paragraphs so they don’t begin with a number. If your document has sections, it must have the same number of notes and note references within each section, which is why it may not be a good idea to strip notes to text to the end of the document only and not to the ends of sections (see “To Location” under “Stripping Notes to Text,” above).

2. Note references must be formatted as superscript, either directly or with a character style, or with the Footnote Reference or Endnote reference character style. If they’re formatted not as one of those but as raised text (or something else), the program won’t work. If you need to, you can use Word to find raised formatting and replace it with superscript formatting before using the program. (Note references don’t have to be numbers; they can also be letters or other characters. They cannot, however, be embedded note reference numbers, which are not actually numbers but are rather a special code.)

3. If you tell the program to find note numbers formatted as superscript (see “How to Strip Text to Notes,” below), nothing but note references must be formatted as superscript in your document’s body text. This is because the program sees any other superscript body text (as  in “1st” or “2nd” or “3rd” or “4th”) as a note reference. Your note numbers, however, can be superscript without causing any problems. Watch out for spaces that have been formatted as superscript—but you can search for these, just as you can ordinals. If you tell the program to find note numbers formatted as Footnote Reference or Endnote reference character styles (see “How to Strip Text to Notes,” below), then you don’t have to worry about this.

4. Note references must be positioned in your text where you want the embedded notes to be. In other words, the embedded notes will be placed where the note references initially appear.

5. The notes must be the last thing in the document or section of the document. They must follow the body text at the end of a section or document, and they can’t have other text following them within a section or at the end of a document. If they do, the program will see that text as part of the last note.

6. Each note must begin with a note number, include some note text, and end with a carriage return. A note cannot begin with a space, tab, or other non-numerical character. Numbers only! Otherwise, NoteStripper has no way to recognize a note as a note. (You can search for problem notes with the code string ^p^w^# using Word’s Find feature. This will find any number preceded by a tab or space preceded by a carriage return.) A single note may, of course, include more than one paragraph.

7. Note numbers must be composed of numbers: 1, 2, 3, 4, 5, 6, 7, 8, 9, and 0. Letters and other characters will not work because the program sees them as note text, not as part of a note number. (Note: Previous versions of NoteStripper saw an initial number following a note number [“3. 1999 was a good year . . .”] as part of the note number and stripped it out. This problem is now fixed.)

Fortunately, most reasonably formatted documents already follow these rules. That means you may not have to do anything to your document before stripping text to notes. However, it doesn’t hurt to look over a document and make sure that the rules have been followed. (And be sure to back up your document before running the program in case you don’t get the results you wanted.)

You should also know that note numbers can be followed by a period and a space (or a tab), but they don’t have to be. Note numbers can have any formatting, including superscript, and they can have any number of digits. Also, you can have as many notes as you want. Finally, your document can include notes that are already embedded. The new notes will be stripped in with the existing notes where they belong.

Here is an example of a document that would work properly:

This is body text.1 This is body2 text. This is body text.3
1. This is note text.

2. This is note text.

3. This is note text.

Here’s another example, using superscript note numbers:

This is body text.1 This is body2 text. This is body text.3
1This is note text.

2This is note text.

3This is note text.

And believe it or not, this example would also work just fine because it follows the rules above, however strange it may look:

This is body text.54 This is bodyabc text. This is body text.2
33. This is note text.

4500
This is note text.

8This is note text.

In each of these cases, after stripping text to notes, you’d get a document that had the notes embedded and automatically renumbered. The document would look like this (with the notes embedded, of course):

This is body text.1 This is body2 text. This is body text.3
1 This is note text.

2 This is note text.

3 This is note text.

How to Strip Text to Notes

To strip text to notes, follow these steps:

1. Open the document in which you want to strip text to notes.

2. Place your cursor at the beginning of the notes, either at the end of a section or the end of your document. (This is so important that the program will ask you if you have done it. If you haven’t, but you say you have, the program will see any paragraph beginning with a number [like this paragraph] as a note and report that you have unmatched notes and note references.)

3. Click the NoteStripper menu under ETKPlus.

4. Click “Text to Notes.”

5. Answer the questions that appear on your screen.

The following dialog will be displayed:
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Select the options you want to use. You can have the program look for note references formatted as superscript, Footnote Reference character style, or Endnote Reference character style. Which one you choose, of course, depends on how the note references are actually formatted in your document. Usually, they will simply be superscript, and even if they’re formatted with one of the character styles, they are still likely to be superscript. Let’s say, however, that they’re formatted with one of the character styles, and you tell the program to find note references formatted with that style. Then your document can contain superscript text other than note references without warning you that note references and note numbers don’t match. Please note, too, that NoteStripper’s Notes to Text feature (see above) does format note references in the character styles and not just as superscript.

After the program runs, your typed notes will be embedded as automatically renumbering Word notes. Then, if you like, you can use Word’s note options to change numbering schemes, formatting, and so on. See your Word documentation for more information.

Stripping Delimited Text to Notes

On occasion, you may encounter documents with notes included as inline text in some kind of delimiters, <<like this.>> You can use NoteStripper to turn such notes into true embedded footnotes or endnotes. Tagged text from typesetting programs—Ventura, for example—often includes delimited notes, as do many public-domain texts available on the Internet. To use this feature:

1. Click the NoteStripper menu.

2. Click “Delimited Text to Notes.”

3. Specify the documents you want to use.

3. In the dialog box, enter the beginning and ending delimiters used with your inline notes. You can use Word’s standard Find codes in these boxes if you need to. For example, you can use ^p to specify a carriage return and ^t to specify a tab.
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4. Select footnotes or endnotes.

5. If your document contains more than one section, you can tell the program to restart numbering at 1 in each section. If you don’t select this option, notes will be numbered consecutively throughout the document.

6. Click the “OK” button.

Stripping Notes to Parenthetical Citations

In some documents you may decide that source citations should appear in parentheses rather than in footnotes or endnotes. In that case, you can use NoteStripper to strip out Word’s embedded notes and place the note text in parentheses where the note references used to be. You can do this with footnotes, endnotes, or both.

To do so:

1. Click the NoteStripper menu under ETKPlus.

2. Click “Notes to Parenthetical Text.”

3. Answer the questions on your screen.

Your notes will be converted into parenthetical citations.

After the program is finished, you may want to go through your document to see if some of the citations should be in brackets rather than in parentheses. This would be true if the program placed a parenthetical citation at the end of text that is already in parentheses, or if your notes already contained publication information in parentheses. I’ve provided a program to help you solve this problem. To run the program, click “Check for Nested Parentheses” under the NoteStripper menu. The program will identify the first nested parentheses it sees. Then it will stop so you can fix them. To find more nested parentheses, run the program again. For ease of use, this program is also available from the NoteStripper button bar.

Stripping Parenthetical Citations into Notes

In some documents you may decide that source citations should appear in footnotes or endnotes rather than in parentheses in the document’s body text. In that case, you can use NoteStripper to strip out the parenthetical citations and turn them into Word’s embedded, automatically renumbering footnotes or endnotes.

To do so:

1. Click the NoteStripper menu under ETKPlus.

2. Click “Parenthetical Text to Notes.”

The program will ask you to choose the type of notes you want to convert:

1. Footnotes.

2. Endnotes.

Click the option you want, then click “OK.”

Next, the program will ask you to choose the type of entries you want to convert:

1. All entries.

2. Individual entries.

Click the option you want, then click “OK.”

If you select “Individual entries,” the program will find each occurrence of parenthetical text and present you with several options:
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1. Convert the current entry.

2. Go to the next entry, leaving the current entry untouched.

3. Undo the previous conversion.

4. Convert all remaining entries from the cursor position to the end of the document.

5. Cancel the program at the current cursor position.

Converting entries individually takes longer than having the program do them all automatically, but it allows you to preserve parenthetical text that should not be turned into a note. If you’re certain that everything in parentheses should be turned into a note, click “All entries.”

If you have only a few places where parentheses should be preserved, and you know where they are, you could manually change them into something like three “at” signs: @@@. Then you could have NoteStripper automatically convert the other parenthetical citations. Finally, you could go back and change all occurrences of three “at” signs into the proper parentheses.

Transposing Reference Numbers and Punctuation

After you’ve stripped parenthetical text to notes, you may find that you’ll need to transpose reference numbers and punctuation, depending on the format of your original parenthetical text. For example, if you’ve formatted parenthetical text the way it appears after this sentence, you’ll have no problem. (Lyon, Using NoteStripper, p. 10.) This parenthetical note is self-contained because the preceding sentence and the note itself both end with a period. The note text will convert perfectly into an embedded note because it ends with a period, and the reference number will appear to the right of the sentence’s period, where it belongs, like this.1
However, if you’ve formatted parenthetical text the way it appears after this sentence, you’ll have problems (Lyon, Using NoteStripper, p. 10). The text of the note will be embedded without a final period because the text inside the parentheses has no period. In addition, the reference number will appear to the left of the sentence’s period, like this1. (I’m tempted here to go off on a diatribe about other reasons why this form of citation is wrongheaded, but I’ll try to resist.)

As part of NoteStripper, I’ve supplied a program to help you fix this problem. The program transposes each reference number with the punctuation that follows it. Depending on how your notes are punctuated, however, the program may not fix them perfectly. After running the macro, you’ll need to look at your notes to make sure they’re formatted and punctuated to your liking. If your notes had no terminal punctuation inside their parentheses, you’ll have to add it after they’re embedded. Sorry, but this is too complicated for a program to handle automatically.

To transpose notes and punctuation:

1. Click the NoteStripper menu under ETKPlus.

2. Click “Transpose Notes and Punctuation.”

The program will ask you to choose which punctuation you would like to include. Your options are:
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1. Periods.

2. Commas.

3. Semicolons.

4. Colons.

5. Question marks.

6. Exclamation marks.

7. Closing parentheses.

8. Closing brackets.

9. Closing braces.

10. Closing angle brackets.

Select as many of these as you’d like. The program will transpose only the notes that are followed by the punctuation you have selected.

Next, the program will ask which notes you’d like to transpose:

1. All notes.

2. Individual notes.

If you choose all notes, the program will run automatically, without your intervention.

If you choose individual notes, the program will stop at each instance of a note followed by the punctuation you specified and ask if you want to transpose. You can:

1. Transpose the note and punctuation.

2. Go to the next instance of a note with punctuation, leaving the current instance untouched.

3. Undo the previous transposition.

4. Transpose all remaining instances from the cursor position to the end of the document.

5. Cancel the program at the current cursor position.

Turning Open-Style Parenthetical Notes into Closed Ones

You can use NoteStripper to turn open-style parenthetical notes into closed ones. To do so:

1. Strip the parenthetical notes into embedded notes.

2. Transpose the embedded notes and punctuation as needed.

3. Add terminal punctuation to the embedded notes as needed.

4. Strip the embedded notes into parenthetical text.

Converting Notes

Buried deep in Microsoft Word’s Insert menu are three commands that allow you to convert footnotes to endnotes and vice versa. You can convert notes in selected text or in an entire document. I’ve included these commands on the NoteStripper menu and button bar for easy access. They include:

1. Convert Footnotes. This command converts footnotes to endnotes.

2. Convert Endnotes. This command converts endnotes to footnotes.

3. Swap Notes. This command converts footnotes to endnotes and endnotes to footnotes.

4. Convert Notes. This command converts selected notes to either footnotes or endnotes.

Using NoteStripper’s Toolbar

NoteStripper includes a toolbar with buttons that activate all of NoteStripper’s functions. The toolbar includes several other handy features for working with notes, including buttons to take you to the next or previous footnote or endnote. You can turn the toolbar on or off as you would any other toolbar in Word:

1. Under the View menu, choose Toolbars.

2. Check or uncheck the box next to the NoteStripper toolbar.

3. Click “OK.”

To see what each button does, use your mouse to point at the button. Then wait a few seconds. A description of the button’s function will appear in a “tool tip” box near your cursor, and a more complete description will appear in the status bar at the bottom of your Microsoft Word window.
QuarkConverter

Thank you for using QuarkConverter™ for Microsoft Word! QuarkConverter translates Microsoft Word documents into XPressTag files that can be imported into QuarkXPress almost automatically. You may find that it cuts your typesetting time and costs in half, especially when used with my FileCleaner and NoteStripper programs.

If you’re planning to use QuarkConverter with documents that contain Word’s automatically numbered footnotes or endnotes, you should first use NoteStripper to strip the notes out as text. Otherwise, QuarkConverter won’t convert your notes correctly for QuarkXPress. If you’re also going to use FileCleaner to clean up common typographical problems, you should run the programs in this order:

1. FileCleaner.

2. NoteStripper.

3. QuarkConverter.

If you’re using Editor’s ToolKit, you can automatically run these three programs in their proper order by clicking the Editor’s ToolKit menu and then clicking “Finish Edited Documents.”

I strongly recommend that you try QuarkConverter several times on a variety of test files until you understand fully how it works and what it can do. Also, before running QuarkConverter at any time, be sure to back up your files. That way, you'll have something to go back to if you're not satisfied with the results.

Understanding QuarkConverter

QuarkConverter was created in response to a real need in a real publishing house to bring documents edited in Microsoft Word into QuarkXPress. According to the QuarkXPress manual, you’re supposed to be able to do this. If you’ve tried it, you know it’s a challenge, at best.

It’s true that you can open a Word or RTF document into QuarkXPress (unless, as sometimes happens, this locks up or crashes your system). The problem is that the imported document retains its formatting, which prevents typesetters from using QuarkXPress as it was meant to be used. One of the beauties of QuarkXPress is that by modifying a document’s style sheet, you can globally change the document’s format—unless, of course, the document has other formatting applied directly, which is what you get when you bring in a Word document. In that case, you can still change the style sheet, but you’ll also have to manually reapply the paragraph styles, which makes little sense. Of course, you could always save your Word document as a text file, losing all formatting, then bring it into QuarkXPress and reapply all of the formatting manually. That doesn’t sound like a good solution either.

XPressTag Files

The answer to this dilemma is to import documents as XPressTag files, which are text files that use tags to mark formatting. For example, an XPressTag file has no italic text. It can’t, since it’s just a text file. Instead, it includes the tag <I> on each side of an italicized word, and when QuarkXPress sees that tag, it turns on italics. When it sees it again (or sees the <$> tag), it turns them off. Similarly, an XPressTag file might include the tag @Heading 1: in front of a paragraph that will be a main heading. When QuarkXPress sees that tag, it formats the following text with the characteristics the typesetter has specified for Heading 1 in the document’s style sheet.

So how do you get an XPressTag file? That’s where QuarkConverter comes in. QuarkConverter turns Microsoft Word documents into XPressTag files that can be brought into QuarkXPress, allowing a typesetter to change type specifications globally. For example, let’s say you’ve been editing in Word and have marked spec levels using paragraph styles (which is what you should do). You used the style Heading 1 for your main headings and Heading 2 as subheads. When you convert your document with QuarkConverter, those headings will be tagged as @Heading 1: and @Heading 2:. Character styles will be tagged as well. Also, most character formatting will be tagged and thus preserved, including bold, italic, underline, word underline, strikethrough, small caps, all caps, superscript, subscript, and raised 3 points. (Such oddities as shadow, outline, double underline, and dotted underline are not supported and will be lost, unless you change them into something else before using QuarkConverter.) QuarkConverter does not convert such formatting as fonts, point size, paragraph formatting, kerning, and so on, all of which should be defined in your QuarkXPress style sheets, not in directly applied formatting.

Character Translation

When you start QuarkConverter, it checks to see if you are working on a PC or a Macintosh. Then it asks you to choose the platform on which you will be using QuarkXPress (Macintosh or PC). This is necessary so that QuarkConverter can properly translate members of the ASCII character set numbered above 128, which are different on the Mac and the PC.

For example, if you have the word fiancé in a PC Word document and bring it into QuarkXPress on the Macintosh, you won’t get fiancé; you’ll get fiancÈ. In general, accented characters don’t translate correctly. Other characters that don’t translate correctly include em dashes, en dashes, bullets, and quotation marks. Ouch! QuarkConverter solves this problem by “hard-coding” these characters into the XPressTag file using ASCII numbers. (For example, <\#147> is the QuarkXPress code for an opening quotation mark on the PC.)

That also means the characters won’t be lost or converted into something else when the document is saved as an XPressTag (text) file. For example, on a PC, if you save the copyright symbol, ©, in a text file, you’ll get this: (c). Saving a.m. (lowercase letters formatted as small caps) in a text file gives you this: A.M. (capitalized letters, which you’d have to lowercase and reformat in QuarkXPress). Saving curly, “smart” quotation marks gives you straight, “un-smart” ones ("like these").

If you tell it to, QuarkXPress will convert straight quotation marks into curly ones on import, but it won’t do it as intelligently as you might like. For example, if you’ve carefully used apostrophes (as opposed to single quotation marks) at the beginning of such abbreviated words as ’tis, ’twas, and ’49er, the distinction will be lost when the document is saved as an XPressTag (text) file. And when the file is imported into QuarkXPress, the apostrophes will become single quotation marks (‘tis, ‘twas, and ‘49er), which you don’t want. QuarkConverter solves this problem. The result is that when you fix apostrophes and quotation marks the way you want them in Microsoft Word, they’ll stay that way when the document is brought into QuarkXPress.
Fixing Typographical Problems

In addition, QuarkConverter eliminates various typographical problems with the following options, which you can select:

1. Placing discretionary hyphens at the beginning of hyphenated words (except those that begin paragraphs, which would prevent using drop caps on those words) and after all hyphens. This prevents such bad end-of-line breaks as self-reli-ance. You never want to break an already broken word, right? I don’t, unless doing so makes the line extremely loose, and in that case you can fix it by hand.

2. Placing discretionary hyphens at the beginning of words joined by an em dash, and after all em dashes between words. This, too, prevents bad breaks.

3. Placing discretionary hyphens at the beginning of contractions, such as couldn’t, shouldn’t, they’re, and so on. (The complete list is couldn’t, didn’t, doesn’t, hadn’t, hasn’t, isn’t, oughtn’t, shouldn’t, they’re, wasn’t, we’re, wouldn’t, and you’re.) I thought about putting discretionary hyphens at the beginning of words that end with a liquid l, such as particle and terrible, but the proper way of handling those is to put them into your QuarkXPress hyphenation exception dictionary. QuarkXPress, as yet, won’t let you include words with apostrophes.

4. Placing nonbreaking spaces after the first two periods in a set of ellipses ( . . . ), and after the first three periods in a set of ellipses followed by a space and then single or double closing quotation marks ( . . . ”). No more broken ellipses, and your ellipses can be justified, too! You’re not using that ugly little ellipses “character” (…), I hope.

Translating Index Entries

Finally, QuarkConverter translates Word index entries into those for QuarkXPress. This makes it possible for an editor or indexer to create an index in a Word document, using Word’s automatic indexing features. When you bring that document into QuarkXPress, the index entries will become Quark index entries, making it possible to generate an index automatically after typesetting and pagination have taken place. This is valuable because editors don’t have to worry about indexing in QuarkXPress, and it also saves time in the production process because indexing can take place—in Word—before rather than after typesetting and pagination.

Microsoft Word and QuarkXPress actually handle indexing quite differently, as you might expect. However, enough overlap exists that QuarkConverter supports and will convert the following index functions from Word:

1. Main entry.

2. Subentry.

3. Sub-subentry (follows a colon after a subentry).

4. Range of pages (marked with a bookmark). This is actually converted to QuarkXPress’s “following number of paragraphs” index entry.

5. See, See also, and See herein.
Please note that if you decide to translate index entries, you must manually insert an XPressTag version code at the top of your document after running QuarkConverter and before bringing the document into QuarkXPress. QuarkConverter can’t do this for you because it has no way of knowing what XPressTag version you are using. To translate index entries, you must have at least version 2.03, and the code at the beginning of your document would look something like this: <2.03>. To find out what version of XPressTags you are using, export a document (“Save Text”) as an XPressTag file from QuarkXPress. Then open the file into Microsoft Word. You’ll see the version code at the top of the document. This is the code you must type in at the top of the files created by QuarkConverter if you want to use automatic index entries.

Saving Files from QuarkConverter

When QuarkConverter is finished, it automatically saves your documents as text files, gives them an .txt extension to differentiate them from your original documents, and places them in the same folder as your original documents. For example, let’s say you used QuarkConverter on a document called DOCUMENT.DOC in a folder called FOLDER. When QuarkConverter was finished, you could look in FOLDER and see your original file, DOCUMENT.DOC, along with a new text file, DOCUMENT.TXT, which is the document you would import into QuarkXPress. Please note that the converted file is not a true XPressTag file because it doesn’t include an XPressTag version code at the top. The .txt extension is to differentiate the converted document from your original one.

Importing XPress Tag Files into QuarkXPress

Importing an XPressTag file into QuarkXPress is a fairly simple matter. In older versions of the program:

1. Create a new document (or open an existing one) in QuarkXPress.

2. Place your cursor into the document where you want the text to begin.

3. Click the File menu.

4. Click “Get Text.”

5. Click “Include Style Sheets.”

6. Find and click the XPressTag file.

7. Click “OK.”

The XPressTag file will be imported into the QuarkXPress document, and you can modify the style sheets to match the type specifications the document is supposed to have.

In more recent versions of QuarkXPress (notably Quark 7), you must include the version tag at the beginning of the XPress Tag file. If you don’t, QuarkXPress won’t recognize it as an Xpress Tags file and won’t give you the option to “Include Style Sheets.”

Actually, that option is no longer even called “Include Style Sheets.” It’s now called “Interpret XPress Tags.” Here’s the procedure for more recent versions of QuarkXPress:

1. Create a new document (or open an existing one) in QuarkXPress.

2. Place your cursor into the document’s text box where you want the text to begin.

3. Click the File menu.

4. Click “Import Text.”

5. Click “Interpret XPress Tags.”

6. Find and click the XPressTag file.

7. Click “OK.”

But remember: For this to work, your XPress Tags file must include the version tag as the first thing in the document. The tag should look something like this:

<v7.31><e0>

To find out what the tag actually is for your version of QuarkXPress, export a document (“Save Text” or “Export Text”) as an XPressTag file from QuarkXPress. Then open the that file into Microsoft Word. You’ll see the version code at the top of the document.

You can type the code manually into an XPress Tags document, but a better solution is to enter the code into the QuarkConverter dialog (in the box on the lower right labeled “Quark version tag”).

Running QuarkConverter

To run QuarkConverter, click the QuarkConverter menu under ETKPlus. QuarkConverter will ask which documents you would like it to work on:

1. The active document.

2. All open documents.

3. All documents in a folder.

Choose the option that fits your needs.

Converting All Documents in a Folder

If you need to convert all documents in a folder, first copy them to a working folder called something like “Copy.” That will leave your original files intact in case you need something to go back to, if necessary. Also, make sure only the files you want to convert are in the Copy folder. Then you won't inadvertently convert, say, some press-ready files that you have spent many hours editing and formatting. Show all files to be sure.

In addition, make sure none of the files is protected or read only. QuarkConverter converts your files and then saves them. If the files are protected or read only, QuarkConverter will not work. You may also run into problems if your files need to be converted into Microsoft Word from a different word-processing format. Please make sure all of your files are in Microsoft Word format before running the program.

If you select the option to convert all the documents in a folder, QuarkConverter presents a dialog box that allows you to select the folder to which you have copied the documents to be converted (leaving your original documents safe in their original folder). After you have selected the Copy folder, click the OK button or press ENTER to continue. On a Macintosh, click “Use Selected Folder.”

Selecting the QuarkConverter Options

After you’ve selected the documents you want to convert, QuarkConverter presents you with options about how you want them converted.

First, it asks you to select the operating system under which you will be using QuarkXPress:

1. QuarkXPress for Macintosh.

2. QuarkXPress for Windows.

Second, it asks you to select certain conversion options (I recommend using all of these unless you have a good reason not to):

1. Tag paragraph styles, either on each paragraph or on each change of style.

2. Tag character styles (with the option to include or exclude character styles named Italic, Bold, Bold Italic, Underline, Strikethrough, Superscript, Subscript, Small Caps, All Caps, and Hidden, which some people use instead of Word’s built-in character formatting [bold, italic, etc.]). Please note that if you use this option, character formatting (such as italic) applied on top of a character style will be lost.

3. Tag character formatting (including bold, italic, underline, strikethrough, superscript, subscript, and raised 3 points). Here you have the option to tag superscript as superior (with the <V> tag) or as superscript (with the <+> tag). Please note that whichever option you choose, formatting raised 3 points will be tagged with the opposite tag (<+> or <V>). Many typesetters prefer the first option, as the second may interfere with leading in QuarkXPress.

4. Tag special characters (such as dashes, quotation marks, and accented characters).

5. Break hyphenated words only after hyphen.

6. Break words joined by em dash only after em dash.

7. Prevent bad breaks on certain words.

8. Prevent breaks on last word of paragraphs.

9. Make ellipses nonbreaking.

10. Convert index entries.

If you decide to tag special characters (which you should), QuarkConverter will include angle brackets as some of those characters. If you already have XPress Tags in your document, that’s a problem because they start and end with angle brackets. You can get around this by formatting your existing XPress Tags in a color: red, green, blue, cyan, yellow, or magenta. Then QuarkConverter will know that they are XPress Tags and won’t tag them as angle brackets—as long as you tell QuarkConverter to preserve existing XPress Tags in the color you’ve used. This option also preserves colored, straight (uncurly) quotation marks, which are sometimes used in XPress Tags.

There’s an easy way to color existing XPress Tags and the information inside them:

1. Click “Edit > Replace” to bring up the Replace dialog.

2. Enter \<*\> in the Find What box.

3. Enter ^& in the Replace With box.

4. With your cursor still in the Replace With box, click the “Format” button (you may need to click the “More” button before this is available).

5. Click “Font.”

6. Click the color you want to use (red, green, blue, cyan, yellow, or magenta).

7. Click “OK.”

8. Put a check in the box labeled “Use Wildcards” or “Use Pattern Matching.”

9. Click “Replace All” to mark everything in angle brackets in the color you selected. If you want to pick and choose which bracketed material to color, click the “Find Next” button and then the “Replace” button as needed.

After you’ve selected the QuarkConverter options you want to use, click “OK.” (If you don’t select any options, QuarkConverter won’t convert your document for QuarkXPress.) The documents will be converted based on your options and saved to their original folders as text files with the extension .txt.

Registering Editor’s ToolKit Plus

If you like Editor’s ToolKit Plus and plan to continue using it, you should purchase a license to do so. If you don't, your copy of the program is for evaluation purposes only, and it will stop working after 45 days or 1,000 uses, whichever comes first. After you purchase a license to use the program, we'll send you a password that will unlock the program to run without limitation on time or use.

The terms of your license prohibit you from giving your program password to someone else or using it on someone else's computer. However, you may use the password on up to three of your own computers. For example, you could install Editor’s ToolKit Plus and use your password on your computer at work, your computer at home, and your laptop. However, you may run the program on only one of your computers at a time. If you need to run the program on more than one computer at a time (for example, for use by a family member or employee), you must purchase another license and get another password for the program. This is the honest and legal thing to do. Besides that, we’re a small company and need your support. Thanks for your cooperation.

Here are the prices for a program license, but these are subject to change without notice:

1 user: $69.95

2-10 users: $39.95

11-49 users: $34.95

50+ users: $29.95

Getting a Password

Here’s how to purchase a program license so you can get your password:

1. Click the Editor’s ToolKit menu at the top of your Word window.

2. Click the “Register Editor’s ToolKit Plus” menu item.

You’ll be presented with two options:

1. Get a password for this computer.

2. Enter the password for this computer.

Click option 1, “Get a password for this computer.” Then click “OK.”

You’ll be presented with two more options:

1. Register on the Internet (at www.editorium.com).

2. Register by mail.

Click the option that meets your needs and follow the instructions on your screen. Registering on the Internet offers some distinct advantages:

1. You’ll receive your password automatically by return email as soon as your payment is processed. If you’re paying by credit card, you’ll receive your password almost immediately. Just check your email as soon as your online registration is complete.

2. You can make your payment in several different forms: credit card, check, or money order. If you don’t pay with a credit card, however, you won’t receive your password until after we receive your payment.

3. You can make your payment in several different ways: on my secure online order form, by fax, or over the phone.

If you're interested in using a purchase order, please let us know by emailing sales@editorium.com.

If you don’t have access to the Internet, you can still register by postal mail. In that case, we’ll send your password by email (if you have it) or postal mail after we receive your check or money order and your registration form. If you’re registering by mail, the program will create a registration form in Microsoft Word. Please fill out the form, using your cursor keys to move from item to item. Then print the form and mail it to the address at the top of the form.

Using Your Password

Once you’ve received your password from the Editorium, you’ll need to enter it into the Editor’s ToolKit Plus program. To do so:

1. Click the Editor’s ToolKit menu at the top of the Word screen.

2. Click the “Register Editor’s ToolKit Plus” menu item.

3. Click “Enter the password for this computer.” Then click “OK.”

The password entry box will appear on your screen. Carefully type the password into the box labeled “Enter your password.”

If you have a valid password and type it correctly, the program will tell you that your registration was successful. After that, the program will run without limitation on time or use.

Thanks for your support!

Troubleshooting

Problem: When you try to open the file to install the program, Microsoft Word tells you that “The macros in this project are disabled . . .”

Solution: Microsoft Word’s macro virus protection is enabled or set to a high level of security. To change this:

In Word 2007 (PC):

1. Click the round Office button at the upper left of your Word window.

2. Click “Word Options”.

3. Click the “Trust Center” button on the left.

4. Click the “Trust Center Settings” button on the right.

5. Select “Enable all macros,” which you should change back to your previous setting after the installation is finished.

6. Click the OK button.

7. Click the next OK button to close the Word Options dialog.

In Word 2004 (Macintosh):

1. Click the “Word” menu.

2. Click “Preferences.” 

3. Click “Security.”

4. Uncheck “Warn before opening a file that contains macros.”

5. Click the OK button.

In Word 2002/XP or 2003 (PC):

1. Click the “Tools” menu.

2. Click “Options.”

3. Click the “Security” tab.

4. Click the “Macro Security” button (on the lower right).

5. Click the “Security Level” tab if it’s not already active.

6. Set your security level to medium and click the OK button.

7. Click the next OK button to close the Options dialog.

In Word 2001 (Macintosh):

1. Click the “Edit” menu.

2. Click “Preferences.”

3. Click the “General” tab if it’s not already active.

4. Uncheck “Macro virus protection.”

5. Click the OK button.

In Word 2000 (PC):

1. Click the “Tools” menu.

2. Click “Macro.”

3. Click “Security.”

4. Click the “Security Level” tab if it’s not already active.

5. Set your security level to medium and click the OK button.

In Word 98 (Macintosh):

1. Click the “Tools” menu.

2. Click “Preferences.”

3. Click the “General” tab.

4. Uncheck the box labeled “Macro virus protection.”

5. Click the “OK” button.

In Word 97 (PC):

1. Click the “Tools” menu.

2. Click “Options”.

3. Click the “General” tab.

4. Uncheck the box labeled “Macro virus protection.”

5. Click the “OK” button.

After installing the program, you may want to reset your security settings to their previous state. If you don’t (in Word 2000 through 2003 on PC), any time you open a document or template that includes macros, Word will give you the choice of whether to disable or enable macros. If the document or template isn’t supposed to have macros in it, you should click the “Disable Macros” button, because the macros could be a virus. If the document or template is supposed to have macros and comes from a source you know is reliable, click the “Enable Macros” button so you can run the macros.

In other versions of Word, you don’t have these options. Macro virus protection is either on or off. Before turning it off permanently you may want to read more about it in Word’s Help file or check with your system administrator.

If you need more help, please send an email message to support@editorium.com.

Problem: Microsoft Word crashes at some point when you’re using the batch features of FileCleaner, NoteStripper, QuarkConverter, or Editor’s ToolKit Plus, such as “Prepare Documents for Editing” or “Finish Edited Documents.”

Solution: Some of your documents may be corrupt. You can identify a document that caused the crash by reading its name in the bar at the top of the Word window when the program crashes. If possible, open the document, copy all of its text, and paste the text into a new document. If you have a number of corrupt documents, you may be able to use the “Add Documents” feature in Editor’s ToolKit Plus to pull them all into one new document. Then you can use the “Split Document” feature to break the new document into new, separate files.

Problem: NoteStripper or FileCleaner have been running for hours while working on just a few short documents.

Solution: Press the Escape key (or maybe CTRL + BREAK) to stop the program. Look at the cursor position in the open document to see if you can figure out what may be causing the problem. If you can, fix the problem before running the program again. Also, check the documents after the problem document to see if they have the same problem.

You’ll especially want to make sure the embedded notes in the original file have been entered correctly. Some people actually do such weird things as open the notes panel, delete the automatic note numbers, and manually type the note numbers with periods and spaces, or they’ll type a heading like “Notes” above the first note, or even headings throughout the notes, such as “Notes to Chapter 10.” I’ve also seen such beauties as automatic note references for which the note numbers and text have been manually typed at the bottom of the document, leaving the notes panel empty.

NoteStripper and FileCleaner operate on the premise that your automatic notes contain note numbers followed by note text—nothing more, nothing less. If your notes have been meddled with so that they’re no longer standard Microsoft Word notes, you can’t expect the programs to work correctly. If you don’t understand how Word’s notes are supposed to work, I urge you read about them in your Word documentation. You may also need to educate your clients about this subject.
Problem: You get weird error messages while using NoteStripper or FileCleaner, and your notes are all garbled and strange when the program quits.

Solution: See the solution to the problem above.

Problem: You’re stripping text notes to embedded notes, but NoteStripper tells you that the number of your notes and references don’t match. Nevertheless, when you count the references and notes manually, they do match. What’s going on?

Solution: Some of your note references may be formatted as raised rather than superscript. If so, NoteStripper doesn’t see them as references and so doesn’t count them. Or, you may have a space or tab in front of some of your notes. If so, NoteStripper doesn’t see them as notes and so doesn’t count them. Another possibility is that whoever typed the note numbers (not references) sometimes used ells for ones. In any of these cases, you’ll need to find the offending references or notes and fix them before proceeding with NoteStripper.

Problem: You’re stripping text notes to embedded notes, and some of your notes’ text starts with numbers, such as a year. When you strip text to notes, those numbers disappear.

Solution: As explained in the “rules” for stripping text to notes (above), the text of a note cannot start with a number. If it does, NoteStripper will see that number as part of the note number, and, yes, the number will disappear after being stripped. You may need to reword such notes so that their text doesn’t start with a number. We’re trying to find a way around this, but it’s a complex programming problem.

Problem: QuarkConverter won’t convert your automatic footnotes or endnotes.

Solution: QuarkConverter doesn’t work on automatic footnotes or endnotes. For QuarkConverter to work on notes, you first have to turn them into text in the body of your document. My NoteStripper program was created for this purpose.

Problem: When you try to import a file containing index entries into QuarkXPress, you get an error message.

Solution: Make sure your version of QuarkXPress supports index entries and that you’ve typed the XPressTag version code at the beginning of the file.

Any Questions?

We hope you find Editor’s ToolKit Plus to be immensely useful. If you have any questions, comments, or thoughts about how it could be improved, please let us know.

support@editorium.com

www.editorium.com

The Editorium

P.O. Box 702601

Salt Lake City, UT 84170  USA

The Editorium provides word-processing tools for editors, writers, typesetters, and other publishing professionals. If you like Editor’s ToolKit Plus, you may also be interested in MegaReplacer, which finds and replaces multiple words, phrases, and even styles in multiple documents.

You can download fully functioning evaluation copies of my programs free of charge from the Editorium’s site on the World Wide Web at www.editorium.com.

This documentation and the Editor’s ToolKit Plus software are copyright © 1996, 1999, 2001 by the Editorium. All rights are reserved. The Editorium, Editor’s ToolKit, Editor’s ToolKit Plus, MegaReplacer, FileCleaner, NoteStripper, QuarkConverter, and AutoStyler are trademarks of the Editorium.

All trademarks mentioned in this documentation or the program are acknowledged as trademarks of their owners.

Appendix 1: Word Functions for Editors

Here are some Word functions with which you should be thoroughly familiar if you’re editing in Word. Please consult your Word manual and Help file for information on these all topics.

Annotations

AutoCorrect

AutoFormat

AutoText

Bookmarks

Change Case

Character Formats (italic, bold, and so on)

Cross References

Document Properties

Draft View

Find

Font

Full Screen

Go Back

Go To

Grammar

Index and Tables

Insert

New Window

Normal, Outline, Page Layout, and Master Document Views

Notes

Options

Paragraph Formats (centered, justified, and so on)

Protect Document

Redo

Replace

Revisions

Save As (including file conversions)

Show All

Sort Text

Spell

Spike

Style Gallery

Styles

Symbols

Templates

Thesaurus

Toolbars

Underline

Undo

Of course, you should also understand such basic functions as opening, closing, and saving documents; manipulating windows; moving around and among documents; and entering, selecting, deleting, cutting, copying, and pasting text.

Terms of Agreement

By using Editor’s ToolKit Plus, you agree to these terms:

LICENSE AGREEMENT

The Editor’s ToolKit Plus software and its documentation (collectively the Software) are protected by the United States copyright laws and international treaties and are owned solely and entirely by the Editorium.

You (the licensee) may run the Software on up to three computers (but only on one at a time) during its evaluation period and (if you purchase a license to do so) after that. You may not copy or sell the Software for commercial gain.

You may freely transfer copies of the Software to others for evaluation. You may NOT let someone else use your password for the Software or rent or lease your license to run it, but you may transfer the license to someone else who accepts this agreement.

You may not modify, reverse engineer, decompile, disassemble, unencrypt, or create derivative works from the Software. You may not use the Software in any manner that infringes the intellectual property or other rights of another party.

DISCLAIMER OF WARRANTY AND LIABILITY

The Editorium disclaims all warranties on the Software, expressed or implied, including but not limited to warranties of merchantability and fitness for any particular application, use, or purpose. You use it at your own risk.
Under no circumstances, including its own negligence, shall the Editorium or its suppliers be liable for any special, incidental, or consequential damages or loss that result from the use of, or the inability to use, the Software.

This agreement shall be construed, interpreted, and governed by the laws of the State of Utah in the United States of America.

